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Computerens
diagnosticeringsfunktioner

Diagnostics for Windows

I hjelpeprogrammet DFW (Diagnostics for Windows) kan du fa vist
oplysninger om computerens hardware- og softwarekonfiguration, mens
Microsoft Windows XP kgrer. Det giver dig mulighed for at udfgre
hardware- og softwaretest af computerens undersystemer.

Nar du starter Diagnostics for Windows, vises et oversigtsbillede
med computerens aktuelle indstillinger. Herfra har du adgang til en
reekke kategorier med oplysninger om computeren samt fanen Test.
Oplysningerne pa hjelpeprogrammets enkelte skaermbilleder kan
gemmes i en fil eller udskrives.

Log pa som administrator, hvis du vil teste alle undersystemer.

Hvis du ikke logger pa som administrator, vil du ikke kunne teste alle
undersystemer. Den manglende mulighed for at teste et undersystem

angives med en meddelelse under navnet pa undersystemet i testvinduet
eller med nedtonede afkrydsningsfelter, der ikke kan markeres.

Brug Diagnostics for Windows til at finde ud af, om alle de enheder,
der er installeret pa computeren, bliver genkendt af systemet og
fungerer korrekt. Det er valgfrit, om du vil kgre en test efter
installation eller tilslutning af en ny enhed, men det anbefales.

Tredjeparts enheder, der ikke understgttes af HP, bliver muligvis ikke
fundet af Diagnostics for Windows. Gem, udskriv eller les de
oplysninger, der genereres af hjelpeprogrammet. Du bgr kgre en test
og have den udskrevne rapport klar, for du ringer til vores
kundeservice.

Vejledning til fejlfinding
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Finde Diagnostics for Windows

Nogle computere leveres med Diagnostics for Windows forindlest,
men ikke forinstalleret. Du har maske installeret det tidligere sammen
med andre hjelpeprogrammer, eller det er maske blevet installeret af
en anden bruger.

Sadan finder du ud af, om Diagnostics for Windows er installeret:

1. Ga ind pa det sted, hvor Diagnostics-ikonerne er placeret.
I Windows XP Home eller Windows XP Professional skal
du velge Start > Kontrolpanel.

2. Se pé de viste ikoner i Kontrolpanel.

O Huvis der vises ikoner til Configuration Record og Diagnostics
for Windows, er hjelpeprogrammet Diagnostics for Windows
installeret.

O Huvis der ikke vises ikoner til Configuration Record og
Diagnostics for Windows, er hjelpeprogrammet Diagnostics
for Windows maske indlast, men ikke installeret.

Installation af Diagnostics for Windows

Hvis Diagnostics for Windows ikke er forindlast, kan du hente
programpakken Diagnostics for Windows pa fglgende websted:

www.hp.com/support

Fglgende er kun ngdvendigt, hvis diagnoseprogrammet er indlast
pa harddisken, men ikke installeret.

1. Luk alle Windows-programmer.
2. Installer hjelpeprogrammet Diagnostics for Windows:

O Vealg Start > installationsprogrammets ikon i Windows XP.
Vealg Diagnostics for Windows > knappen Next, og fglg
derefter anvisningerne pa skeermen.

0 Hoyvis installationsprogrammets ikon ikke vises pa skrivebordet
eller i menuen Start, kan du kgre installationsprogrammet fra
mappen C:\CPQAPPS\DIAGS cller velge Start > Kgr
og skrive fglgende pa kommandolinjen:
C:\CPQAPPS\DIAGS\SETUP.

1-2
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3. Klik pa Next for at installere Diagnostics for Windows.

4. Du bliver muligvis bedt om at genstarte computeren, eller det
sker automatisk, nér installationen af programmet er feerdig. Klik
pa Finish for at genstarte computeren, hvis du bliver bedt om det,
eller pa Cancel for at afslutte programmet. Genstart computeren
for at fuldfgre installationen af Diagnostics for Windows.

Hvis du vil opgradere en eksisterende version af Diagnostics
for Windows, der er installeret p4 computeren, kan du besgge
www.hp.com/support for at finde og hente den seneste version
af Diagnostics for Windows SoftPagq.

Brug af kategorier i Diagnostics for Windows

Fglg fremgangsmaden nedenfor for at bruge kategorier:

1. Klik pa Start > HP Information Center > Diagnostics for
Windows. Du kan ogsé vaelge ikonet Diagnostics for Windows
i Kontrolpanel ved at klikke pa Start > Kontrolpanel og derefter
vaelge Diagnostics for Windows.

Skarmen viser oversigten over computerens hardware og software.

2. Velg en kategori i rullemenuen Categories eller det relevante
ikon pa varktgjslinien for at fa oplysninger om specifik hardware
og software.

Hvis du flytter markgren hen over ikonerne pa vearktgjslinien,
vises det tilsvarende kategorinavn ved markgren.

3. Klik pad More i boksen Information Level i nederste venstre
hjgrne af vinduet, eller klik pa Level gverst i skeermbilledet,
og veelg More for at fa vist flere detaljerede oplysninger i den
valgte kategori.

4. Gennemse, udskriv og/eller gem oplysningerne efter behov.

Klik pa File, og velg derefter Print for at udskrive oplysningerne.
Velg en af fglgende muligheder: Detailed Report (All Categories),
Summary Report (All Categories) eller Current Category.

Klik pa OK for at udskrive den valgte rapport.

Vejledning til fejlfinding
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% Klik pa File, og vaelg derefter Save As for at gemme oplysningerne.
Velg en af fglgende muligheder: Detailed Report (All Categories),
Summary Report (All Categories) eller Current Category.

Klik pa OK for at gemme den valgte rapport.

5. Klik pa File og klik derefter pa Exit for at afslutte Diagnostics

for Windows.

Menulinje - File, Categories, Navigation, Level, Tab, Help

@verst i skermbilledet Diagnostics for Windows vises menulinien,
der bestar af seks rullemenuer:

File — Save As, Print, Printer Setup, Exit

Categories — Med en oversigt over kategorierne i fglgende afsnit
Navigation — Forrige kategori (F5), Neaste kategori (F6)

Level — Ferre (F7), Flere (F8) <oplysninger pa skeermen>

Tab — Overview, Test, Status, Log, Error

Help — Contents, How to use Help, About

Vzerktgijslinje - Ikoner for forskellige kategorier af oplysninger

Under menulinien vises en raekke ikoner pd verktgjslinjen for
hver af fglgende kategorier med oplysninger om computeren:

System — Oplysninger om systemkort, ROM, dato og klokkeslet

Asset Control — Oplysninger om asset-tag, systemets
serienummer 0g -processor

Input Devices — Oplysninger om tastatur, mus og joystick
Communication — Oplysninger om systemets porte
Storage — Oplysninger om systemets lagerdrev

Graphics — Oplysninger om grafiksystemet

Memory — Oplysninger om systemkortets og Windows’
hukommelse

Multimedia — Oplysninger om optisk lager (cd, dvd osv.) og lyd

Windows — Oplysninger om Windows

www.hp.com Veijledning til fejlfinding
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Architecture — Oplysninger om PCI-enheden
Resources — Oplysninger om IRQ, I/0 og hukommelsesmapping
Health — Status for systemets temperatur og harddiske

Miscellaneous — CMOS, DMI, BIOS, system, produktnavn
0g serienummer

Tab - Overview, Test, Status, Log, Error

Der er fem faner under varktgjslinjen:

Overview — Oversigtsvinduet indeholder generelle oplysninger

om computeren. Det er dette vindue, der vises, f@rste gang

du starter hjelpeprogrammet. I vinduets venstre side vises
hardwareoplysningerne, og i hgjre side vises softwareoplysningerne.

Test — Brug vinduet Test til at valge de dele af systemet, du vil
teste. Du kan ogsé valge testtype og testtilstand.

Status — Vinduet Status indeholder oplysninger om status for den
igangveerende test. Du kan annullere testen ved at klikke pa
knappen Cancel Testing.

Log — Vinduet Log indeholder en log over test for de enkelte
enheder.

Error — Vinduet Error viser eventuelle fejl, der opstod under test
af enheden. Vinduet viser, hvilken enhed der testes, fejltypen og
antal fejl samt fejlkoden.

Sadan keres en diagnosticeringstest i Diagnostics

for Windows

Sadan kgres en diagnosticeringstest:

1. Klik pa Start > HP Information Center > Diagnostics for

Windows. Du kan ogsa valge ikonet Diagnostics for Windows
i Kontrolpanel ved at klikke pa Start > Kontrolpanel, og derefter
valge Diagnostics for Windows.

Skarmen viser oversigten over computerens hardware og software.
Der vises fem faner under raekken med ikoner: Overview, Test,
Status, Log og Error.

. Klik pa fanen Test, eller klik pa Tab gverst pa skaermen, og velg

derefter Test.

Vejledning til fejlfinding
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3. Valg en af fglgende muligheder:

a

Quick Test — Kgrer en hurtig generel test af de enkelte enheder.
Kraver ikke brugerens indgriben, hvis der er valgt Unattended
Mode.

Complete Test — Udfgrer en maksimal test af de enkelte enheder.
Brugeren kan valge Interactive Mode eller Unattended Mode.

Custom Test — Kgrer kun de tests, du velger. Find enheden
pa listen, og klik i afkrydsningsfeltet ved siden af hver test
for at veelge bestemte enheder eller test. En rgd markering
vises i afkrydsningsfeltet, nar det er valgt. Visse af de valgte
test kan krave brugerens indgriben.

Log pa som administrator, hvis du vil teste alle undersystemer. Hvis
du ikke logger pa som administrator, vil du ikke kunne teste alle

undersystemer. Den manglende mulighed for at teste undersystemet
angives med en meddelelse under navnet pa undersystemet i vinduet
Test eller med nedtonede aftkrydsningsfelter, der ikke kan markeres.

4. Valg Interactive Mode eller Unattended Mode. I Interactive
Mode beder diagnoseprogrammet dig om input under de test,
hvor det er pakravet. Nogle test kraver en handling og viser
fejl eller stopper testen, hvis de valges i Unattended Mode.

a

a

Interactive Mode giver optimal kontrol over testforlgbet.
Du bestemmer, om testen er lykkedes eller mislykkedes,
og du kan blive bedt om at tilslutte eller afbryde enheder.

I Unattended Mode vises ingen prompts. Hvis der findes fejl,
vises de, nar testen er fuldendt.

5. Klik pa knappen Begin Testing nederst i vinduet. Testens status
vises tillige med forlgbet og resultatet af hver test. Klik pa fanen
Log, eller klik pa Tab gverst pa skaermen, og valg derefter Log for
at fa flere oplysninger om testkgrsler.

1-6
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6. Valg en fane for at fa vist en testrapport:

0  Under fanen Status opsummeres testkgrslerne, bade dem
som lykkedes, og dem som mislykkedes, i den aktuelle
testsession.

0  Under fanen Log vises testkgrslerne pa systemet, antallet
af gange hver test er kgrt, antallet af fejl der er fundet under
hver test og den samlede kgrselstid for hver test.

0 Under fanen Error vises alle de fejl, der er fundet pa computeren,
med de tilhgrende fejlkoder.

7. Sadan gemmes en testrapport:

O Velg fanen Log og knappen Save for at gemme en rapport
under fanen Log.

O  Vealg fanen Error og knappen Save for at gemme en rapport
under fanen Error.

8. Sédan udskrives en testrapport:

O Hyvis rapporten ligger under fanen Log, skal du velge
File > Save As og derefter udskrive filen fra den valgte
mappe.

O Hyvis rapporten ligger under fanen Error, skal du valge fanen
Error og knappen Print.

9. Klik pa fanen Error for at fa vist supplerende oplysninger
og anbefalede handlinger, hvis der opstar fejl. Hvis du fglger
de anbefalede handlinger, kan du muligvis selv lgse nogle af
problemerne.

10. Klik pa Udskriv, eller gem fejlmeddelelserne i tilfelde af, at du
skal kontakte en autoriseret forhandler eller serviceyder for at
fa assistance.

11. Klik pa File, og klik derefter pa Exit for at afslutte Diagnostics
for Windows.

Vejledning til fejlfinding www.hp.com 1-7
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Hjelpeprogrammet Configuration Record

Hjelpeprogrammet Configuration Record er et Windows-

baseret program til informationssggning, der minder om andre
administrationsprogrammer. Programmet indsamler vigtige oplysninger
om hardware og software fra forskellige computerundersystemer og
giver et fuldsteendigt overblik over computeren. Configuration Record
giver mulighed for automatisk identifikation og sammenligning af
konfigurations@ndringer og kan vedligeholde en konfigurationshistorik
for pc’en. Oplysningerne kan gemmes som en oversigt over flere
sessioner.

Dette hjelpeprogram er udviklet, for at problemer kan lgses,

uden at computeren skal offline, og for at maksimere computerens
tilgengelighed. Oplysningerne, der indsamles med dette program,
er nyttige ved fejlfinding i forbindelse med systemproblemer og
strgmliner serviceprocessen, fordi konfigurationen nemt og hurtigt
kan identificeres, hvilket er fgrste trin i serviceopgaven.

Hj=lpeprogrammet Configuration Record indsamler oplysninger

om hardware og operativsystem og giver et omfattende overblik

over systemet. Der indsamles og vises oplysninger om f.eks. ROM,
asset-tag, processor, fysiske drev, PCI-enheder hukommelse, grafik,
operativsystemets versionsnummer, operativsystemets parametre og
operativsystemets startfiler. Hvis den oprindelige Base.log-fil findes
i mappen cpgdiags, vises filen Base.log ved siden af filen Now.log i et
opdelt vindue, og forskellene mellem filerne er markeret med rgdt.

Installation af Configuration Record

Configuration Record er en del af Diagnostics for Windows. Nar
du installerer Diagnostics for Windows, installeres Configuration
Record samtidig.

1-8 www.hp.com Veijledning til fejlfinding



Computerens diagnosticeringsfunktioner

Sadan keres Configuration Record

Sadan kgres dette program:

1. Klik pa Start > HP Information Center > Configuration
Record. Du kan ogsa valge ikonet Configuration Record
i Kontrolpanel ved at klikke pa Start > Kontrolpanel,
og derefter velge Configuration Record.

% Hj®lpeprogrammet Configuration Record har to visningsmuligheder:
Show Changed Items Only og Show All. Standardvisningen er
Show Changed Items Only, hvor al tekst vises med rgdt, fordi
det kun er forskellene, der vises. Skift til Show All for at fa vist
en komplet og altomfattende oversigt over systemet.

2. Standardvisningen er Show Changed Items Only. Klik pa
View gverst i vinduet, og velg Show All, eller klik pa ikonet
Show All Items for at fa vist alle oplysninger, der er indsamlet
med Configuration Record.

3. Velg File > Save Window File, og velg derefter Left Window
File eller Right Window File for at gemme oplysningerne i venstre
eller hgjre vindue.

% Ved regelmassigt at gemme computerens konfiguration kan brugeren
vedligeholde en konfigurationshistorik. Denne historik er nyttig for
serviceyderen, hvis der opstér problemer, der skal lgses.

4. Klik pa File, og klik derefter pa Exit for at afslutte Configuration
Record.
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Beskyttelse af softwaren

Tag sikkerhedskopier af al software, alle programmer og relaterede filer,
der er lagret pa harddisken for at undga tab af data eller beskadigelse
af softwaren. I dokumentationen til operativsystemet eller programmerne
til sikkerhedskopiering kan du finde anvisninger pa, hvordan du
sikkerhedskopierer datafilerne.

Gendannelse af softwaren

Med Restore Plus! kan du gendanne operativsystemet Windows
og programmerne, som de var, da du kgbte computeren. Se
dokumentationen, der felger med Restore Plus! pa cd’en for

at fa komplette anvisninger om at bruge funktionen.

www.hp.com Veijledning til fejlfinding
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Fejlfinding uden diagnose

Dette kapitel indeholder oplysninger om, hvordan du finder og retter
mindre problemer, f.eks. problemer med diskettedrev, harddisk, optisk
drev, grafik, lyd, hukommelse og software. Se skemaerne i dette kapitel
for at finde arsagen og de anbefalede Igsninger, hvis der opstér problemer
med computeren.

% Oplysninger om specielle fejlmeddelelser, der vises pa skeermen
under POST (Power-On Self-Test) ved start af computeren, finder
du i Appendiks A, “POST-fejlmeddelelser.”

Sikkerhed og komfort

ADVARSEL: Forkert brug af computeren eller negligering af oprettelsen
af et sikkert og behageligt arbejdsmiljg kan medfere gener eller alvorlige
skader. Se Vejledning om sikkerhed og komfort p& dokumentations-cd’en
eller p& webstedet www.hp.com/ergo for at f& yderligere oplysninger om
at vaelge arbejdsomrdde og skabe et sikkert og behageligt arbejdsmilje.

Dette udstyr er blevet testet og overholder graenserne for en digital enhed
i Klasse B, ifelge Del 15 i FCC-regulativerne. Yderligere oplysninger finder
du i Oplysninger om sikkerhed og regulativer p& dokumentations-cd’en.

Vejledning til fejlfinding www.hp.com 2-1


http://www.hp.com/ergo

Fejlfinding uden diagnose

For du ringer til teknisk support

Hvis du har problemer med computeren, kan du prgve de relevante
Igsninger herunder for at finde det ngjagtige problem, f@gr du ringer
til teknisk support.

B Kor hjzlpeprogrammet Diagnostics for Windows: Se Kapitel 1,
“Computerens diagnosticeringsfunktioner” for at fa flere oplysninger.

B Kogr DPS (Drive Protection System) Self-Test i computerens
opsa&tningsprogram. Se Vejledning til computeropscetning (F10)
pa dokumentations-cd’en for at fa yderligere oplysninger.

B Kontroller lysdioden for strgmforsyning pa computerens
forside for at se, om den blinker rgdt. De blinkende lysdioder
er fejlkoder, som ggr det lettere at diagnosticere problemet. Se
Appendiks A, “POST-fejlmeddelelser” for at fa flere oplysninger.

B Hovis skermen er tom, og der findes et andet skermistik, skal du
tilslutte skeermen til det. Du kan ogsa udskifte skermen med en
skeerm, som du ved fungerer korrekt.

B Hovis du arbejder i et netveark, skal du prgve at tilslutte en anden
computer med et andet computerkabel til netverksstikket. Der
kan vere problemer med netverksstikket eller kablet.

B Hovis du har tilfgjet ny hardware for nylig, skal du fjerne hardwaren
igen, og kontrollere om computeren nu fungerer korrekt.

B Hovis du har tilfgjet ny software for nylig, skal du fjerne installationen
af softwaren, og kontrollere, om computeren fungerer korrekt.

B Start computeren i fejlsikret tilstand for at se, om den starter,
uden at alle driverne er indlast. Nar du starter operativsystemet,
skal du vaelge den senest kendte konfiguration.

B Se den omfattende tekniske support online pa
www.hp.com/support.

B Se afsnittet “Nyttige tip” i denne brugerhandbog.
B Kogr cd’en Restore Plus!.

FORSIGTIG: Ndr du kerer cd’en Restore Plus! slettes alle data
pé harddisken.
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HP Instant Support Professional Edition indeholder en selvdiagnosti-
cering, som hjelper dig med at lgse problemer online. Anvend online-
chatfunktionen i HP Instant Support Professional Edition, hvis du har
brug for at kontakte HP Support. Du har adgang til HP Instant Sup-
port Professional Edition pé adressen: www.hp.com/go/ispe.

Du har adgang til vores supportcenter for virksomheder (BSC) pa
adressen www.hp.com/go/bizsupport, og her kan du fa de seneste
oplysninger om onlinesupport, software og drivere, proaktiv besked
og kommunikere med ligestillede samt HP-eksperter i hele verden.

Hyvis det bliver ngdvendigt at ringe efter teknisk hjelp (1-800-652-6672),
skal du vere klar til at udfgre fglgende handlinger for at sikre,
at serviceopkaldet bliver handteret korrekt:

B Szt dig foran computeren, nér du ringer.

B Noter computerens serienummer, produkt-id-nummer samt
skermens serienummer, fgr du ringer.

B Brug tid pé at finde arsagen til problemet sammen med
serviceteknikeren.

B Afbryd den hardware, der senest er blevet tilsluttet systemet.

B Fjern installationen af de programmer, der for nylig er blevet
installeret.

B Kor cd’en Restore Plus!.

FORSIGTIG: Ndr du kerer cd’en Restore Plus! slettes alle data
pd harddisken.

>

Oplysninger om salg og garantiopgraderinger (Care Packs) fas ved
henvendelse til den lokale autoriserede serviceudbyder eller
forhandler.

g
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Nyttige tip

Hyvis der opstar problemer med computeren, skeermen eller softwaren,
kan du se fglgende liste med generelle lgsningsforslag, inden du foretager

dig yderligere:

B Kontroller, at pc’en og skaermen er tilsluttet en stikkontakt,
der virker.

B Kontroller, at speendingsvealgeren (pa visse modeller) er angivet
til den rette spanding for dit omrade (115 V eller 230 V).

B Kontroller, at pc’en er tzndt, og at den grgnne lysdiode for
strgm lyser.

B Kontroller, at skaermen er tendt, og at den grgnne lysdiode
for skaermen lyser.

B Kontroller lysdioden for strgmforsyning pa computerens forside
for at se, om den blinker rgdt. De blinkende lysdioder er fejlkoder,
som ggr det lettere at diagnosticere problemet. Se Appendiks A,
“POST-fejlmeddelelser” for at fa flere oplysninger.

B Skru op for lysstyrken og kontrasten pa skaermen, hvis skermen
er for mgrk.

B Tryk pa en vilkarlig tast, og hold den nede. Hvis systemet bipper,
fungerer tastaturet korrekt.

B Se alle kabelforbindelser efter for lgse eller ukorrekte forbindelser.

B Vzk computeren ved at trykke pa en vilkarlig tast pa tastaturet

eller ved at trykke pa afbryderen. Hvis systemet forbliver i standby,
skal du slukke computeren ved at trykke pa og holde afbryderen
nede i mindst fire sekunder. Tryk derefter pa afbryderen igen for
at genstarte computeren. Hvis systemet ikke slukkes, skal du tage
stikket ud af kontakten, vente i nogle fa sekunder og tilslutte det
igen. Computeren genstartes, hvis den er indstillet til automatisk
start efter strgmafbrydelse i computerens ops@tningsprogram. Hvis
computeren ikke genstartes, skal du trykke pa afbryderen for at
starte den.

www.hp.com Veijledning til fejlfinding



Fejlfinding uden diagnose

B Omkonfigurer computeren efter installation af et udvidelseskort
eller andet tilbehgr, der ikke er plug and play-enheder. Se
“Afhjelpning af problemer med installation af hardware” for
at fa vejledning.

B Sgrg for, at alle ngdvendige enhedsdrivere er installeret. Hvis
du f.eks. bruger en printer, skal du ogsé bruge en driver til den
pageldende printermodel.

B Tag alle startmedier ud (diskette, cd eller USB-enhed) af systemet,
for du teender det igen.

B Hovis du har installeret et andet operativsystem end det, der var
installeret fra fabrikken, skal du kontrollere at det understgttes
pa dette system.

B Hoyvis der er installeret flere skermkilder (integreret, PCI- eller
PCI-Express-adaptere) pa computeren (kun integreret skeerm pa
udvalgte modeller) og kun en enkelt skerm, skal du tilslutteskermen
i skeermstikket pa den kilde, der er valgt som den primare
VGA-adapter. Under start deaktiveres de andre skaermstik, sa
hvis du tilslutter skeermen til en af disse porte, fungerer den ikke.
Du kan valge den kilde, der skal vaere VGA-standardkilden,

i computerens ops&tningsprogram.

fi FORSIGTIG: Nar pc'en er tilsluttet en stikkontakt, er der altid strem
p& systemkortet. Netledningen skal tages ud af stikkontakten, inden pc’en
&bnes, for at forhindre beskadigelse af komponenterne eller systemkortet.
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Afhjzlpning af generelle problemer

Du kan méaske nemt selv Igse de generelle problemer, der er beskrevet
i dette afsnit. Hvis problemet fortsatter, og du ikke selv kan Igse det,
eller hvis du ikke fgler dig sikker pa en handling, skal du kontakte en

autoriseret forhandler.

Afhjzlpning af generelle problemer

Problem Arsag Lesning

Pc’en synes last Softwarestyringen Tryk p& afbryderknappen, og hold
og slukker ikke, af afbryderknappen den nede i mindst fire sekunder,

nér der trykkes pa fungerer ikke. indtil computeren slukker.
afbryderknappen.

Computeren reagerer Computeren er Tryk p& afbryderen for at genoptage
ikke p& USB-tastaturet i standby. fra standby.

eller musen.

Systemet er last.

Genstart computeren.

FORSIGTIG: Tryk ikke p& afbryderknappen i mere end fire sekunder, nér du forseger
at genoptage fra standby. | modsat fald slukkes computeren, og du mister data.

Computerens dato og Batteriet til realtidsuret
klokkeslaet er forkert. skal muligvis skiftes.

@y, Tilslutning af

computeren til en
aktiv stremkontakt
forlenger levetiden
for batteriet fil
realtidsuret.

Nulstil ferst dato og klokkeslaet
under Kontrolpanel (computerens
opsaetningsprogram kan ogsd bruges
til ot opdatere realtidsdato og -klokke-
slaet). Hvis problemet fortszetter, skal
du udskifte batteriet til realtidsuret.
Se Hardwarevejledningen pa
dokumentations-cd’en for at f&
vejledning i iszetning aof et nyt batteri,
eller kontakt en autoriseret forhandler for
at f& udskiftet batteriet til realtidsuret.

Markeren kan ikke Tasten Num Lock
fiyttes ved hjaelp er muligvis aktiveret.
af piletasterne

pd tastaturet.

Tryk pé tasten Num Lock. Lysdioden
for Num Lock méa ikke lyse, hvis du vil
bruge piletasterne. Du kan deaktivere
(eller aktivere) tasten Num Lock

i computerens opsaetningsprogram.
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Afhjzelpning af generelle problemer (Fortsat)

Problem

Arsag

Lesning

Computerens deekplade
eller adgangspanel kan
ikke fiernes.

Smart Coverldsen,
som findes pé& nogle
computere, er l&st.

L&s Smart Cover-lasen op ved hjzlp af
computerens opsaetningsprogram (F10).

Hos HP kan du kebe en Smart Cover
FailSafe-negle, der kan deaktivere
Smart Coverldsen manuelt. Du skal
have en FailSafe-nggle i tilfeelde aof,
at adgangskoden bliver vaek, f.eks.
ved stramsvigt eller funktionsfejl. Bestil
varenummer 166527-001 for ngglen
eller varenummer 166527-002 for

skruetraekkeren.

Ydelsen er nedsat.

Processoren er varm.

1. Kontroller, at luftstrammen til
computeren ikke er blokeret.

2. Konftroller, at ventilatorerne er
tilsluttet og fungerer korrekt
(visse ventilatorer fungerer kun,
nér der er behov for det).

3. Kontroller, at processorens
kelekappe er korrekt monteret.

Harddisken er fuld.

Overfer data fra harddisken for
at frigere mere plads p& harddisken.

lkke meget ledig
hukommelse.

Tilfaj mere hukommelse.

Harddisk fragmenteret.

Defragmenter harddisken.

Det program, som tidligere
havde adgang, frigjorde
ikke reserverethukommelse
til systemet igen.

Genstart computeren.

Virus resident pa

harddisken.

Ker et virusbeskyttelsesprogram.

For mange programmer
er dbne.

1. Luk alle ungdvendige programmer
for at frigere hukommelse.

2. Tilfaj mere hukommelse.

Arsag ukendt.

Genstart computeren.

Vejledning til fejlfinding
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Afhjzelpning af generelle problemer (Fortsat)

Problem Arsag Lesning

Computeren slukkede Processorens termiske 1. Serg for, at computerens
automatisk, og den beskyttelse er aktiveret: ventilationshuller ikke er blokeret,
rede lysdiode for stram  Eqy ventilator er muligvis og at processorens keleventilator
blinker fo gange hvert  plokeret eller roterer ikke. kerer.

sekund, efterfulgt af en
pause pd to sekunder,

og computeren bipper Kelekappen er ikke
to gange. monteret korrekt pé

processoren.

ELLER 2. Abn laget, tryk pa afbryderen,
og kontroller, at processorens
ventilator drejer rundt. Hvis
processorens ventilator ikke
drejer rundt, skal du kontrollere,
at ventilatorkablet er tilsluttet
systemkortets header. Kontroller,
at ventilatoren er placeret eller
installeret korrekt.

3. Hvis processorens ventilator
er tilsluttet og placeret korrekt,
men ikke drejer rundt, skal

du udskifte den.

4. Seet processorens keleklap
pd igen, og kontroller, at
ventilatoren er monteret korrekt.

5. Kontakt en autoriseret forhandler
eller serviceyder.
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Afhjzelpning af generelle problemer (Fortsat)

Problem Arsag Lesning

Systemet taendes ikke, Systemet kunne Tryk p& og hold afbryderen nede
og lysdioderne pa ikke teendes. i mindre end fire sekunder. Hvis
computerens forside harddiskens lysdioder lyser grent,
blinker ikke. skal du gere felgende:

1. Kontroller, at spaendingsvaelgeren
bag pd stremforsyningen (pé
udvalgte modeller) er angivet
til den rette spaending. Den
rette indstilling of spaendingen
afhaenger aof det aktuelle omréde.

2. Fjern udvidelseskortene et ad
gangen, indtil lysdioden 3 V_aux
p& systemkortet lyser.

3. Udskift systemkortet.
ELLER

Tryk p& og hold afbryderen nede

i mindre end fire sekunder. Hvis
harddiskens lysdiode ikke lyser grent,
skal du derefter gare falgende:

1. Kontroller, at enheden er filsluttet
et fungerende stremstik.

2. Abn laget, og kontroller, at
afbryderen er tilsluttet korrekt
til systemkortet.

3. Kontroller, at begge
stremforsyningskabler er
filsluttet korrekt til systemkortet.

4. Kontroller, at lysdioden 3 V_aux
pd systemkortet lyser. Hvis den
lyser, kan du tilslutte afbryderen
igen.

5. Hvis lysdioden 3 V_aux p&
systemkortet ikke lyser, skal du
bruge en anden stremforsyning.

6. Udskift systemkortet.
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Afhjzlpning af problemer med stremforsyningen

Tabellen i det fglgende indeholder almindelige arsager og Igsninger
pa problemer med strgmforsyningen.

Afhjelpning af problemer med stremforsyningen

Problem

Arsag

Lesning

Stremforsyningen lukker af
og til ned.

Spaendingsvaelgeren
bag p& computerens
kabinet (pé& visse
modeller) stér ikke pa
den korrekte spaending

(115 Veller 230 V).

Veelg den korrekte spaending
med vaelgerkontakten.

Stramforsyningen
teender ikke, pga.

en fejl p& den interne
stremforsyning.

Kontakt en autoriseret
tienesteudbyder for at
udskifte stremforsyningen.

Computeren slukkede
automatisk, og den rede
lysdiode for strem blinker
to gange hvert sekund,
efterfulgt of en pause pé to
sekunder, og computeren
bipper to gange.

Processorens termiske
beskyttelse er aktiveret:
En ventilator er muligvis
blokeret eller drejer ikke
rundt.

ELLER
Kelekappen er ikke

monteret korrekt pa
processoren.

1. Serg for, at computerens ventila-
tionshuller ikke er blokeret, og at
processorens keleventilator kerer.

2. Abn laget, tryk p& afbryderen,
og kontroller, at processorens
ventilator drejer rundt. Hvis
processorens ventilator ikke
drejer rundt, skal du kontrollere,
at ventilatorkablet er tilsluttet
systemkortets header. Kontroller,
at ventilatoren er placeret eller
installeret korrekt.

3. Hvis processorens ventilator
er tilsluttet og placeret korrekt,
men ikke drejer rundt, skal du

udskifte den.

4. Seet processorens keleklap
pd igen, og kontroller, at
ventilatoren er monteret korrekt.

5. Kontakt en autoriseret forhandler
eller serviceyder.

www.hp.com

Veijledning til fejlfinding



Fejlfinding uden diagnose

Afhjelpning af problemer med stremforsyningen (Fortsat)

Problem Arsag Lesning

Den rgde lysdiode for Stremsvigt 1. Kontroller, at spaendingsvaelgeren
strem blinker fire gange (stremforsyningen bag pd stremforsyningen

pr. sekund, efterfulgt of er overbelastet). (p& visse modeller) er angivet

en pause pé to sekunder,
og computeren bipper
fire gange.

til den rette spaending. Den
rette indstilling af spaendingen
afhaenger aof det aktuelle omrade.

. Abn laget, og kontroller at

fireleder-stremforsyningskableter
tilsluttet stikket p& systemkortet.

. Kontroller, om en enhed foré&rsager

problemerne, ved at fierne ALLE
tilsluttede enheder (f.eks. harddisk,
diskettedrev eller optiske drev og
udvidelseskort). Teend systemet.
Hvis systemet skifter til POST,
skal du slukke og udskifte en
enhed ad gangen og gentage
proceduren, indtil fejlen
forekommer. Udskift den enhed,
der forarsager fejlen. Fortsaet
med at tilfaje enhederne én

ad gangen for at sikre, at alle
enheder fungerer korrekt.

. Kontakt en autoriseret

tienesteudbyder for at
udskifte stremforsyningen.

5. Udskift systemkortet.

Vejledning til fejlfinding www.hp.com
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Afhjzelpning af disketteproblemer

SN

Tabellen i det fglgende indeholder almindelige arsager og Igsninger
pa problemer med disketter.

Det kan vere ngdvendigt at rekonfigurere pc’en, nér du tilfgjer eller
fjerner hardware, som f.eks. et ekstra diskettedrev. Se “Afhjalpning af
problemer med installation af hardware” for at fa vejledning.

Afhjzelpning af disketteproblemer

Problem

Arsag

Lesning

Lysdioden for diskettedrev

forbliver taendt.

Disketten er beskadiget.

| Microsoft Windows XP skal du
hajreklikke p& Start, klikke pa
Stifinder og valge et drev.

Velg Filer > Egenskaber >
Funktioner. Klik p& Undersag nu
under Status for fejlsegning.

Disketten er ikke
korrekt isat.

Tag disketten ud, og szet den i igen.

Drevkablet er ikke
tilsluttet korrekt.

Saet drevkablet i igen. Kontroller,
at alle fire ben pd diskettedrevets
stramkabel er sluttet til drevet.

Drevet kan ikke findes.

Kablet sidder lgst.

Seet diskettedrevets stram- og
datakabel i igen.

Det flytbare drev er
ikke korrekt placeret.

Saet drevet i igen.

Diskettedrevet kan ikke

skrive til disketten.

Disketten er ikke
formateret.

Formatér disketten.

1. Veelg drev (A) i Windows
Stifinder.

2. Heojreklik pa drevbogstavet,
og veelg Formater.

3. Velg de anskede indstillinger,
og klik p& Start for at begynde
formateringen af disketten.

Disketten er
skrivebeskyttet.

Brug en anden diskette, eller fjern
skrivebeskyttelsen.

www.hp.com
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Afhjzelpning af disketteproblemer (Fortsat)

Problem

Arsag

Lesning

Diskettedrevet kan ikke

skrive til disketten. (fortsat)

Der skrives til det
forkerte drev.

Kontrollér drevbogstavet i drevstien.

Der er ikke tilstraekkelig
plads pé& disketten.

1. Brug en anden diskette.
2. Slet ungdvendige filer fra disketten.

Skrivning fra
legacydiskette

er deaktiveret

i computerens
opsaetningsprogram.

Kar computerens opsaetningsprogram,
og aktiver Legacy Diskette Write
under Storage > Storage
Options.

Disketten er beskadiget.

Udskift den beskadigede disk.

Disketten kan ikke
formateres.

Der er angivet et
ugyldigt medie.

Angiv diskettens kapacitet, nar du
formaterer en diskette i MS-DOS. Hvis
du f.eks. skal formatere en 1,44 MB-
diskette, skal du skrive falgende
kommando ved MS-DOS-prompten:

FORMAT A: /F:1440

Disketten er mdske
skrivebeskyttet.

Abn diskettens laseanordning.

Disketten er
skrivebeskyttet.

Ker computerens opsaetningsprogram,
og aktiver Legacy Diskette
Write under Storage > Storage
Options.

Der er opstéet et problem

med en diskoverfersel.

Biblioteksstrukturen er
forkert, eller der er
opstdet en fejl i en fil.

| Windows XP skal du hgjreklikke
p& Start, klikke pa Stifinder
og valge et drev. Veelg Filer >
Egenskaber > Funktioner.
Klik p& Underseg nu under
Status for fejlsegning.

Diskettedrevet kan ikke
laese en diskette.

Du bruger den forkerte
diskettetype til drevet.

Kontrollér, at du bruger
den rigtige diskettetype.

Der laeses fra det
forkerte drev.

Kontrollér drevbogstavet i drevstien.

Disketten er beskadiget.

Skift disketten ud med en anden.

Vejledning til fejlfinding
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Afhjzelpning af disketteproblemer (Fortsat)

Problem

Arsag

Lesning

Meddelelsen “Ugyldig
systemdisk” vises.

Der sidder en diskette,
som ikke indeholder
systemfiler, der kan starte
computeren, i drevet.

Tag disketten ud, nar
drevaktiviteten stopper, og
tryk p& mellemrumstasten.
Computeren skulle starte nu.

Der opstod en
diskettefejl.

Genstart computeren ved
at trykke pd& afbryderen.

Der kan ikke bootes
fra disketten.

Disketten er ikke
en bootdiskette.

Isset en diskette, der kan bootes fra.

Boot fra diskette

er deaktiveret

i computerens
opsaetningsprogram.

1. Ker computerens
opseetningsprogram, og
aktiver boot fra diskette
i Storage > Boot Order.

2. Ker computerens
opsaetningsprogram,
og aktiver boot fra diskette
under Storage > Storage
Options > Removable
Media Boot.

SN Be%ge trin ber bruges som
funktionen til boot fra et
udtageligt medie, Removable
Media Boot i computerens
opsaetningsprogram og
overskriver aktiveringskom-
mandoen for startraekkefalgen,
Boot Order.

Netvaerksservertilstanden
er aktiveret

i computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og deaktiver Network Server
Mode i Security > Password
Options.

Boot fra flytbart
medie er deaktiveret
i computerens
opsaetningsprogram.

Kar computerens opsaetningsprogram,
og aktiver boot fra flytbart medie

i Storage > Storage Options >
Removable Media Boot.

www.hp.com
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Harddiskproblemer

Afhjzelpning af harddiskproblemer

Problem

Arsag

Lesning

Fejl p& harddisken.

Harddisken har
beskadigede sektorer
eller er géet ned.

1. I Windows XP skal du hgjreklikke
p& Start, klikke pa Udforsk
og valge et drev. Velg Filer >
Egenskaber > Funktioner.
Klik p& Underssg nu under
Status for fejlsagning.

2. Brug et hjzelpeprogram
til at finde og forhindre
brugen af de dérlige sektorer.
Genformatér harddisken,
hvis det er nedvendigt.

Problem med
diskoverfarslen.

Enten er der fejl i
biblioteksstrukturen,
eller der er opstaet
en fejl i en fil.

I Windows XP skal du hgjreklikke p&
Start, klikke p& Udforsk og vaelge
etdrev. Velg Filer > Egenskaber >
Funktioner. Klik p& Underseg nu
under Status for fejlsagning.

Drevet kan ikke findes
(identificeres).

Kablet er muligvis lgst.

Kontrollér kabelforbindelserne.

Systemet har muligvis
ikke genkendt en
nyinstalleret enhed
automatisk.

Se anvisningerne for ny konfiguration
i afsnittet “Afhjaelpning of
problemer med installation

af hardware”. Kontroller, om
enheden findes pd listen i
computerens opsaetningsprogram,
hvis systemet stadig ikke genkender
den nye enhed. Hvis enheden
findes pa listen, er der sandsynligvis
tale om et driverproblem. Hvis den
ikke findes pa listen, er arsagen
sandsynligvis et hardwareproblem.
Abn computerens opsastningsprogram,
og forsag at tilfeje en pause

i POSTHorsinkelse under
Advanced > Power-On.

Vejledning til fejlfinding
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Afhjzelpning af harddiskproblemer (Fortsat)

Problem

Arsag

Lesning

Drevet kan ikke findes
(identificeres).
(fortsat)

Drevets
jumperindstillinger
er muligvis forkerte.

Hvis det er et masterdrev, skal
jumperen indstilles bag pé drevet
til Master eller Cable Select (vaelg
kabel). Hvis det er et slavedrey,
skal jumperen indstilles til Slave
eller Cable Select (vaelg kabel).

Drevets controller

er deaktiveret

i computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og aktiver alle IDE- og SATA-
controllere | Storage > Storage
Options.

Drevet reagerer

langsomt lige efter start.

Ker computerens opsaetningsprogram,
og @g indstillingen af POST-
forsinkelsen under Advanced >
Power-On Options.

Meddelelse om
ikke-systemdisk/NTLDR

mangler.

Systemet forseger
at starte fra en diskette,

der ikke kan startes fra.

Tag disketten ud af diskettedrevet.

www.hp.com
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Afhjzelpning af harddiskproblemer (Fortsat)

Problem Arsag Lesning

Meddelelse om Systemet forseger at 1. Seet en diskette, der kan startes
ikke-systemdisk/NTLDR starte fra harddisken, fra, i diskettedrevet, og genstart
mangler. men den er muligvis computeren.

(fortsat) beskadiget. . Kontroller harddiskens format

med fdisk:

Ved NFTFS-formatering kan
du bruge en tredjeparts leeser
til at vurdere drevet.

Ved FAT32-formatering er der
ikke adgang til harddisken.
Udskift MBR-billedet.

. Hvis der stadig ikke er

adgang til harddisken, nér

der er startet fra en diskette, og
MBR- sikkerheden er aktiveret,
kan du forsege at gendanne

en MBR-kopi, du tidligere

har gemt. Ker computerens
opsaetningsprogram, og vaelg
Security > Restore Master
Boot Record for at gere dette.
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Afhjzelpning af harddiskproblemer (Fortsat)

Problem

Arsag

Lesning

Meddelelse om

ikke-systemdisk/NTLDR

mangler.
(fortsat)

Systemfilerne mangler
eller er ikke installeret
korrekt.

1. Saet en diskette, der kan startes
fra, i diskettedrevet, og genstart
computeren.

2. Kontroller harddiskens format
med Fdisk:
Ved NFTFS-formatering kan du
bruge en tredjeparts leeser til at
vurdere drevet.
Ved FAT32-formatering er der
ikke adgang til harddisken.
Udskift MBR-billedet.

Hvis der stadig ikke er adgang il
harddisken, nar der er startet fra

en diskette, og MBR-sikkerheden er
aktiveret, kan du forsage at gendanne
en MBR-kopi, du tidligere har gemt.
Ker computerens opsaetningsprogram,
og veelg Security > Restore
Master Boot Record for at

gere dette.

Start fra harddisk er
deaktivereti computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og aktiver harddisken pa listen
Storage > Boot Order.

En harddisk, der kan
startes fra, er ikke
installeret ferst i en
konfiguration med

flere harddiske.

Hvis du forsgger at starte fra en
IDE-harddisk, skal du sikre dig, at
den er installeret som primaer enhed O.
Hvis du forseger at starte fra en
SATA-harddisk, skal du sikre dig,

at den er tilsluttet SATA 0.

Controlleren til

en harddisk, der
kan startes fra,
stér ikke overst

i startraekkefalgen.

Abn computerens opsaetningsprogram,
og velg Storage > Boot Order,
og kontroller at controlleren til den
harddisk, der skal startes fra, er anfert
lige under linjen Hard Drive.

Parallel ATA-harddisk (PATA)

fungerer ikke optimalt.

Du bruger det forkerte
kabel til drevtypen.

Geninstaller Ultra ATA-harddisken
med et 80-polet kabel.
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Afhjzelpning af harddiskproblemer (Fortsat)

Problem

Arsag

Lesning

Computeren starter ikke.

Harddisken
er beskadiget.

Se om lysdioden pé frontpanelet
blinker redt, og om der heres
biplyde. Se Appendiks A,
“POSTHejlmeddelelser” for at finde
de mulige arsager til, at lampen
blinker redt, og laes bipkoderne.
Se vilkér og betingelser i

den verdensomspaendende
begraensede garanti.

Computeren synes |&st.

Programmet, der er
i brug, er holdt op

med at reagere pa
kommandoerne.

Forseg den normale fremgangsmade
for nedlukning i Windows. Tryk pa
afbryderen i mindst fire sekunder
for at slukke for strammen, hvis

en normal nedlukning ikke lykkes.
Tryk p& afbryderen igen for

at genstarte computeren.

Afhjzelpning af MultiBay-problemer

Afhjelpning af MultiBay-problemer

Problem

Arsag

Lesning

Drevet kan ikke findes.

Du har forsagt en hot
plug-ilslutning af

et flytbart drev, hvor
Drivelock-sikkerheden
er aktiveret. (Funktionen
understattes kun pa
udvalgte modeller).

Luk Windows, og sluk computeren.
Seet drevet i MultiBay, hvis det
ikke allerede er installeret. Taend
computeren.

MultiBay er deaktiveret
i computerens
opsaetningsprogram.

/&bncomputerensopsaetningsprogrom,
og indstil MultiBay til Device
Available i Security >

Device Security.

Vejledning til fejlfinding
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Afhjzelpning af problemer med skzermen

Hvis der opstér problemer med skarmen, skal du se i dokumentationen,
der fulgte med skeermen, og i tabellen med almindelige arsager og
lgsninger nedenfor.

Afhjzelpning af problemer med skaermen

Problem

Arsag

Lesning

Sort skaerm (ingen visning).

Skaermen er ikke taendt,
og lysdioden for
skaermen lyser ikke.

Teend skaermen, og kontroller
at lysdioden for skaerm lyser.

Forkert skaerm.

Prev en anden skaerm.

Kabeltilslutningerne er
ikke korrekte.

Kontroller kabelforbindelserne
mellem skaermen, computeren
og stikkontakten.

Der er mdske installeret
en funktion til sort skaerm,
eller funktionerne til
energibesparelse er
aktiveret.

Tryk pé en vilkarlig tast, eller klik
med museknappen, og skriv din
adgangskode, hvis den er defineret.

Der er fejl i
systemhukommelsen,
og systemet kerer

i Failsafe Boot
Blocktilstand (angives
med otte biplyde).

Flash ROM’en igen ved hjeelp of
en ROMPag-diskette. Se i afsnittet
“Failsafe Boot Block ROM”

i Desktop Management Guide

p& dokumentations-cd’en for

at f& flere oplysninger.

Du bruger en skaerm
med fast synkronisering,
og synkronisering er
ikke mulig ved den
valgte oplasning.

Serg for, at skeermen kan
acceptere samme vandrette
scanningshastighed som
oplesningen.

Computeren er

i standby.

Tryk p& afbryderen for at genoptage
fra standby.

A FORSIGTIG: Tryk ikke p& afbryderknappen i leengere tid end fire sekunder,
nar du forseger at genoptage fra standby. | modsat fald slukkes computeren,

og du mister data.
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Afhjzelpning af problemer med skarmen (Fortsat)

Problem

Arsag

Lesning

Sort skaerm (ingen visning).
(fortsat)

Skaermkablet sidder
i det forkerte stik.

Hvis systemet har béde et integreret
grafikstik og et skaermstik til
tilfajelseskort, skal skaermkablet
saettes i grafikkortets stik bag

p& computeren.

Hvis grafikkortet er et standard
PCl-udvidelseskort, kan du
aktivere den integrerede grafik

i computerens opsaetningsprogram.
Hvis et grafikkort af typen PCl-Express
er installeret, kan den integrerede
grafik ikke akfiveres.

Skaermindstillingerne
i computeren er ikke
kompatible med
skaermen.

1. Genstart computeren, og tryk
pd F8 under start, nér du ser
“Press F8” i nederste hgjre
hjerne af skaermen.

2. Veelg Enable VGA Mode
med piletasterne pé& tastaturet,
og tryk pé Enter.

3. Dobbeltklik p& ikonet Skaerm
i Windows Kontrolpanel, og
valg fanen Indstillinger.

4. Brug skyderen til at nulstille
oplasningen.

Skaermen er tom, og den
rede lysdiode for strom
blinker fem gange pr. sekund,
efterfulgt of en pause pé to
sekunder, og computeren
bipper fem gange.

Hukommelsesfeil
for videomodul.

1. Saet DIMM-modulerne i igen.
Teend systemet.

2. Udskift DIMM-modulerne et ad
gangen for at isolere det modul,
der ikke fungerer.

3. Udskift tredjepartshukommelse
med HP-hukommelse.

4. Udskift systemkortet.

Vejledning til fejlfinding
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Afhjzelpning af problemer med skarmen (Fortsat)

Problem Arsag Lesning
Skaermen er tom, og Grafikfejl for For systemer med et grafikkort:
den rade lysdiode for videomodul. 1. Seet grafikkortet rigtigt i

strem blinker seks gange
pr. sekund, efterfulgt of
en pause pé to sekunder,

Teend systemet.
2. Udskift grafikkortet.

og computeren bipper 3. Udskift systemkortet.

seks gange. Udskift systemkortet, hvis systemet
har et integreret grafikkort.

Skaermen er tom, og Fejl p& systemkortet Udskift systemkortet.

den rede lysdiode for (fejl sporet i ROM

strem blinker syv gange for skeermmodulet).

pr. sekund, efterfulgt af
en pause pd to sekunder,
og computeren bipper

syv gange.
Skaermen fungerer ikke Du bruger en skaerm, Deaktivér funktionerne
korrekt, nér den bruges der ikke understatter til energibesparelse.
sammen med funktionerne  energibesparelse,
til energibesparelse. med funktionerne
til energibesparelse
aktiveret.
Tegnene er utydelige. Knapperne for lysstyrke  Reguler skaermens lysstyrke-
og kontrast er ikke og kontrastknapper.
indstillet korrekt.
Kablerne er ikke tilsluttet  Serg for, at grafikkablet sidder
korrekt. fast i grafikkortet og skaermen.
Skaermbilledet er utydeligt,  Hvis grafikcontrolleren Installér skeermdriverne, der
eller den valgte oplasning  er opgraderet, er de fulgte med opgraderingen.
kan ikke indstilles. korrekte grafikdrivere

muligvis ikke indlaest.

Skaermen kan ikke vise  Skift oplasning.
den oplasning, der
anmodes om.

Forkert grafikkort. Udskift grafikkortet.
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Afhjzelpning af problemer med skarmen (Fortsat)

Problem

Arsag

Lesning

Billedet er brudt, det ruller,
ryster eller blinker.

Forbindelserne til
skaermen er ikke
korrekte, eller skaermen
kan vaere forkert
justeret.

1. Serg for, at skaermkablet er
sluttet korrekt til computeren.

2. | et toskeermssystem, eller hvis
en anden skaerm er anbragt
taet pd, skal du serge for,
at skaermene ikke forstyrrer
hinandens elekiromagnetiske
felt ved at flytte dem vaek
fra hinanden.

3. lysstofrer eller ventilatorer er
méske for taet p& skaermen.

Skaermen skal
afmagnetiseres.

Afmagnetiser skaermen. Se i
dokumentationen, der fulgte med
skaermen, for yderligere anvisninger.

Vibrationer eller raslelyde,
der kommer inde fra en
CRT-skserm, ndr den
teendes.

Skaermens
afmagnetiseringsspole
er aktiveret.

Ingen. Det er normalt, at
afmagnetiseringsspolen aktiveres,
ndr skaermen taendes.

Klikkelyde, der kommer
inde fra en CRT-skaerm.

Elektroniske relscer
er aktiveret inde
i skaermen.

Ingen. Det er normalt, at visse
skaerme laver en klikkelyd, nér

de teendes og slukkes, nar standby
aktiveres eller deaktiveres, og nér
oplasningen aendres.

Der kommer hgje lyde
inde fra en fladskaerm.

Indstillingerne for
lysstyrke og/eller
kontrast er for haje.

Valg en lavere indstilling for
lysstyrke og/eller kontrast.

Vejledning til fejlfinding
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Afhjzelpning af problemer med skarmen (Fortsat)

Problem Arsag Lesning

Uskarpt fokus, striber, Fladskaermens 1. Veelg skaermindstillingen
spogelsestryk eller interne digitale for automatisk justering
skyggevirkninger, konversionskredse i skeermmenuen.

vandret ru||end§ |.in]er, kan muligvis_ikke 2. Synkroniser manuelt

svage lodrette linjer, fortolke grafikkortets funktionerne til visning

eller billedeot kan ikke udgangssynkronisering af uret og clockfrekvensen
centreres p& skaermen. korrekt. pé& skaermen. Hvis du vil hente

(gaelder kun fladskaerme,
der bruger en analog

VGA-indgangstilslutning)

en programpakke til at hjaelpe
dig med at synkronisere, skal
du ga til falgende websted,
valge den relevante skaerm
og hente enten SP20930 eller
SP22333:
www.hp.com/support

Grafikkortet er ikke 1. Saet grafikkortet rigtigt i.

korrekt installeret, eller 2 Udskift arafikkortef
det er et forkert kort. - Udskitt gratikkortet.

Visse trykte symboler vises  Den skrifttype, du Brug tegnoversigten til at finde og

ikke korrekt. bruger, understetter vaelge det relevante symbol. Klik
ikke det padgaeldende p& Start > Alle programmer >
symbol. Tilbehor > Systemvzerktgijer >

Tegnoversigt. Du kan kopiere
symbolet fra Tegnoversigten til et
dokument.
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Afhjzelpning af problemer med lyd

Hvis computeren har lydfunktioner, og der opstar problemer med
lyden, skal du se de almindelige arsager og lgsninger, der er angivet
i tabellen nedenfor:

Afhjzelpning af problemer med lyd

Problem

Arsag

Lesning

Lyden slas til og fra.

Processorens ressourcer
bruges af andre

programmer, der er dbne.

Luk alle de programmer,
der kraever processorkraft.

Latenstid for direkte lyd
er almindeligt i mange

medieafspillerprogrammer.

| Windows XP:

1. Veelg Lyde og lydenheder
i Kontrolpanel.

2. Under fanen Lyd skal du veelge
en enhed pé listen Afspilning
af lyd.

3. Klik p& knappen Avanceret,
og veelg fanen Ydeevne.

4. Indstil skyderen
Hardwareacceleration
til Ingen og skyderen for
konverteringskvalitet aof
samplefrekvens til God,
og afprev lyden igen.

Indstil skyderen
Hardwareacceleration

til Fuld og skyderen for
konverteringskvalitet af
samplefrekvens il Bedst,
og afprev lyden igen.

Der kommer ikke lyd
ud af heijttaleren eller
hovedtelefonerne.

Der er skruet ned
for lyden ved hjzlp
af softwaren.

Dobbeliklik p& ikonet Hejttaler

p& proceslinjen, og kontroller derefter,
at Sl& fra ikke er markeret. Brug
skyderen til at indstille lydstyrken.

Lyden er deaktiveret
i computerens
opsaetningsprogram.

Aktiver lyden i computerens
opsaetningsprogram. Security >
Device Security > Audio.

Vejledning til fejlfinding
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Afhjzelpning af problemer med lyd (Fortsat)

Problem

Arsag

Lesning

Der kommer ikke lyd
ud af hgijttaleren eller
hovedtelefonerne.
(fortsat)

De eksterne hgittalere
er ikke taendt.

Teend de eksterne hgijttalere.

De eksterne hgittalere
er tilsluttet det forkerte

lydstik.

Se dokumentationen til lydkortet
vedrarende korrekt tilslutning.

Digital musik-cd er ikke
aktiveret.

Aktiver digital musik-cd:
1. Veelg System i Kontrolpanel.

2. Klik p& fanen Hardware,
og klik derefter p& knappen
Enhedshandtering.

3. Hgjreklik p& enheden CD/DVD,
og veelg Egenskaber.

4. Klik pa fanen Egenskaber,
og kontroller, at Aktiver
digital cd-lyd for denne
cd-rom-enhed er markeret.

Hovedtelefonerne eller
enhederne, der er
filsluttet det udgaende
stik, deemper den interne
haijttaler.

Taend, og brug hovedtelefonerne eller
de eksterne hgittalere, hvis de er
tilsluttet, eller afbryd hovedtelefonerne
eller de eksterne hgittalere.

Lyden er sl@et fra.

1. Klik p& Lyd, Tale og
lydenheder, i Kontrolpanel,
og klik derefter pé Lyd og
lydenheder.

2. Klik p& afkrydsningsfeltet Slé fra
for at fierne markeringen heri.

Computeren er
i standby.

Tryk p& afbryderen for at
genoptage aktivitet fra standby.

A FORSIGTIG: Tryk ikke p& afbryderknappen i mere end fire sekunder, nér du forseger
at genoptage fra standby. | modsat fald slukkes computeren, og du mister data.
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Afhjzelpning af problemer med lyd (Fortsat)

Problem

Arsag

Lesning

Der kommer stgj

eller ingen lyd ud
af hejttaleren eller
hovedtelefonerne.

Computeren registrerer

muligvis ikke den korrekte
haittaler/hovedtelefontype

eller -output, eller
analogil-digital
auto-sense er ikke

aktiveret.

1. Brug stereo-il-mono-adapteren

for at aktivere auto-sense-
funktionen korrekt, hvis du
bruger digitale hgijttalere

med stereostik, og systemet
automatisk skal skifte til digital.

. Brug egenskaberne for

multimedieenhed for manuelt

at andre lydsignalet fra analogt
til digitalt, hvis der ikke er en
tilgeengelig stereo-til-mono-
adapter.

. Brug egenskaberne for

multimedieenhed for at sendre
systemet til analogt output,
hvis hovedtelefonerne har

et monostik.

Oplysninger om, hvordan du aendrer
lydoutputtilstanden, finder du
under Appendiks D, “Indstilling af
analogt/digitalt lydoutput.”

Hvis du veelger digital som outputtilstand, udsender den interne hgittaler og
de eksterne analoge hgittalere ikke lyd, fer du skifter tilbage til en auto-sense- eller

analog tilstand.

Hvis du veelger analog som outputtilstand, fungerer de eksterne analoge
haittalere ikke, for du sendrer outputtilstanden til en auto-sense- og digital tilstand.

Yderligere oplysninger finder du under Appendiks D, “Indstilling af analogt/digitalt

lydoutput”.

Computeren virker last
under musikoptagelsen.

Harddisken er muligvis

fuld.

Kontroller, at der er tilstraekkelig
meget ledig plads pa harddisken.
Du kan ogsa preve at optage
musikfilen i et komprimeret format.

Vejledning til fejlfinding
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Afhjzlpning af problemer med printeren

Hyvis der opstar problemer med printeren, skal du se i dokumentationen
til skeermen og i tabellen med almindelige arsager og lgsninger nedenfor.

Afhjzelpning af problemer med printeren

Problem

Arsag

Lesning

Printeren vil ikke udskrive.

Printeren er ikke taendt

og online.

Teend printeren, og kontroller
at den er online.

De korrekte printerdrivere

til programmet er ikke
installeret.

1. Installér den korrekte
printerdriver til programmet.

2. Prov at udskrive ved hjzlp
af MS-DOS-kommandoen:
DIR C:\ > [printerport]
hvor [printerport] er adressen
pd den printer, der skal bruges.

Genindlaes printerdriveren, hvis
printeren fungerer.

Hvis du er pd et
netvaerk, er du mdske
ikke tilsluttet printeren.

Serg for, at der er korrekt
netvaerkstilslutning til printeren.

Der kan veere en fejl
pd printeren.

Ker printerens selvtest.

Printeren vil ikke taende.

Kablerne er muligvis
ikke tilsluttet korrekt.

Tilslut alle kablerne igen, og kontroller
stremkablet og stikkontakten.

Printeren udskriver
forvanskede tegn.

De korrekte
printerdrivere til
programmet er
ikke installeret.

Installér den korrekte printerdrivere
til programmet.

Kablerne er muligvis
ikke tilsluttet korrekt.

Tilslut alle kabler igen.

Printeren har muligvis
ikke hukommelse nok.

Nulstil printeren ved at slukke
den i et minut, og teend den igen.

Printeren er offline.

Der kan mangle papir
i printeren.

Kontroller papirbakken, og fyld
mere papir i, hvis den er fom.
Vealg online.
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Afhjzlpning af problemer med tastatur og mus

Hyvis der opstar problemer med tastaturet eller musen, skal du se i
dokumentationen til udstyret og i tabellen med almindelige arsager

og lgsninger nedenfor.

Afhjzlpning af tastaturproblemer

Problem Arsag Lesning

Computeren genkenderikke  Tastaturstikket er 1. Klik p& knappen Start
tastaturets kommandoer ikke sat rigtigt i. p& Windows-skrivebordet.
eller det, der skrives med 2. Klik p& Luk computeren.
tastaturet.

Dialogboksen Luk Windows
vises.

3. Klik p& Luk computeren.

4. Slut tastaturet til bag pé
computeren, og genstart
computeren, ndr nedlukningen
er feerdig.

Programmet, der er
i brug, er holdt op

med at reagere pd
kommandoerne.

Luk computeren ned med musen,
og genstart computeren.

Tastaturet skal
repareres.

Se vilkér og betingelser i den
verdensomspaendende begraensede
garanti.

Computeren er
i standby.

Tryk p& afbryderen for at genoptage
fra standby.

A FORSIGTIG: Tryk ikke pa afbryderknappen i laengere tid end fire sekunder, nér du
forsager at genoptage fra standby. | modsat fald slukkes computeren, og du mister data.

Markeren kan ikke flyttes Tasten Num Lock er
ved hjzlp of piletasterne muligvis aktiveret.
pd tastaturet.

Tryk pé tasten Num Lock.
Lysdioden for Num Lock md ikke
lyse, hvis du vil bruge piletasterne.
Tasten Num Lock kan deaktiveres.
(eller aktiveres) i computerens
opsaetningsprogram.

Vejledning til fejlfinding www.hp.com
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Afhjzelpning af museproblemer

Problem

Arsag

Lesning

Musen reagerer ikke, nar
den flyttes, eller den er
for langsom.

Musens stik er ikke
sat korrekt i bag pé
computeren.

Luk computeren ned ved hjzelp
af tastaturet.

1. Tryk pa tasterne Ctrl og Esc
samtidigt (eller tryk pa
Windows-logotasten)
for at f& vist menuen Start.

2. Brug Pil op eller Pil ned til at
vaelge Luk computeren,
og tryk derefter p& Enter.

3. Brug Pil op eller Pil ned til
at vaelge Luk computeren,
og tryk derefter p& Enter.

4. Slut musen til bag pa
computeren (eller tastaturet),
og genstart computeren, ndr
nedlukningen er feerdig.

Programmet, der er
i brug, er holdt op

med at reagere pa
kommandoerne.

Sluk computeren med tastaturet,
og genstart derefter computeren.

Musen skal muligvis
renses.

Tag kugledaekslet af musen, og rens
musens indvendige komponenter.

Musen skal muligvis
repareres.

Se vilkér og betingelser i den
verdensomspaendende begraensede
garanti.

Computeren er

i standby.

Tryk p& afbryderen for at genoptage
aktivitet fra standby.

FORSIGTIG: Tryk ikke pé& afbryderknappen i mere end fire sekunder, nér du forseger
at genoptage fra standby. | modsat fald slukkes computeren, og du mister data.

Musen kan ikke bevaeges
lodret, vandret eller
bevaegelsen sker i ryk.

Musens kugle

er snavset.

Fiern kugledaekslet i bunden
af musen, og renger musen
med et rensesaet, der kan kaobes
i de fleste computerforretninger.
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Afhjzlpning af problemer med installation

af hardware

Det kan vere ngdvendigt at rekonfigurere pc’en, nér du tilfgjer

eller fjerner hardware, som f.eks. et ekstra drev eller udvidelseskort.
Hyvis du installerer en Plug and Play-enhed, genkender Windows XP
automatisk enheden og konfigurerer computeren. Hvis du installerer
en enhed, der ikke understgtter plug and play, skal computeren
rekonfigureres, nar den nye hardware er installeret. Brug guiden
Tilfgj hardware i Windows XP, og fglg vejledningen pa skarmen.

Afhjzelpning af problemer med installation af hardware

Problem

Arsag

Lesning

En ny enhed genkendes

ikke som en del af systemet.

Enheden er ikke isat
eller tilsluttet korrekt.

Serg for, at enheden er tilsluttet

korrekt, og at benene i kabelstikket
ikke er bgjede.

Kablerne i den nye
eksterne enhed er lose,
eller stremkablerne

er ikke tilsluttet en
stremkilde.

Serg for, at alle kablerne sidder

korrekt, og at kablets eller stikkets
ikke er bgjede.

Den nye enheds
afbryder star ikke
pd taendt.

Sluk computeren, taend den
eksterne enhed, og teend derefter
computeren for at integrere enheden
i computersystemet.

Du accepterede ikke
systemets anbefaling
om at aendre
konfigurationen.

Genstart computeren, og felg
vejledningen for at acceptere
andringerne.

Et Plug and Play-kort
konfigureres ikke
automatisk, nér

det tilfgjes, hvis
standardkonfigurationen
er i konflikt med andre
enheder.

Brug Enhedshandtering i Windows XP
til ot fravaelge de automatiske
indstillinger for kortet og vaelge

en grundkonfiguration, der ikke
for&rsager ressourcekonflikt. Du kan
ogsd lzse ressourcekonflikten ved
at genkonfigurere eller deaktivere
enheder ved hjeelp af computerens
opseetningsprogram.
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Afhjzelpning af problemer med installation af hardware (Fortsat)

Problem

Arsag

Lesning

Computeren starter ikke.

Der blev brugt forkerte
hukommelsesmoduler
til opgraderingen, eller
hukommelsesmodulerne
blev installeret det
forkerte sted.

1.

Gennemgd den dokumentation,
der fulgte med systemet, for at
fastslé om du bruger de korrekte
hukommelsesmoduler, og om
installationen er korrekt.

. Hold @je med biplyde

og lysdiodernes signaler
p& computerens forside.
Se Appendiks A,

“POSTHejlmeddelelser” for
at finde de mulige érsager.

. Kontakt kundesupporttjenesten,

hvis du stadig ikke kan lese
problemet.

Den rgde lysdiode for

strem blinker fem gange pr.

sekund, efterfulgt of en
pause pé& to sekunder,
og computeren bipper
fem gange.

Hukommelsen er
installeret forkert
eller fungerer ikke.

. Saet DIMM-modulerne i igen.

Teend systemet.

. Udskift DIMM-modulerne et ad

gangen for at isolere det modul,
der ikke fungerer.

3. Udskift tredjepartshukommelse
med HP-hukommelse.
4. Udskift systemkortet.
Den rgde lysdiode for Skaermkortet er ikke For systemer med et grafikkort:
strem blinker seks gange placeret |'<orrekt eller 1. Seet grafikkortet rigtigt .
pr. sekund, oefterfulgt af fungerer ikke, eller Teend systemet.
en pause pé to sekunder, systemkortet fungerer oo
og computeren bipper ikke. 2. Udskift grafikkortet.
seks gange. 3. Udskift systemkortet.
Udskift systemkortet, hvis systemet
har et integreret grafikkort.
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Fejlfinding uden diagnose

Afhjzelpning af problemer med installation af hardware (Fortsat)

Problem

Arsag Lesning

Den rgde lysdiode for
strem blinker to gange
pr. sekund, efterfulgt of

Forkert tilbehgrskort. 1.

en pause pé to sekunder,

og computeren bipper
ti gange.

3.

Kontroller alle tilbeharskort
ved at tage kortene ud (ét ad
gangen, hvis der er flere kort),
og taend systemet for at se,
om fejlen er reftet.

. Nar du har fundet det

pageeldende kort, skal du
tage det ud og udskifte det.

Udskift systemkortet.

Afhj=lpning af netveerksproblemer

Fglgende tabel indeholder almindelige arsager og Igsninger pa
problemer med netvark. Disse retningslinier handler ikke om

fejlfinding i netvaerkskabelfgringen.

Afhjzelpning af netvaerksproblemer

Problem

Arsag Lesning

Funktionen Wake-on-LAN  Funktionen Wake-on-LAN  Aktiver funktionen Wake-on-LAN.

virker ikke.

er ikke aktiveret. 1

(6,1

. Veelg Start > Kontrolpanel.
2.

Dobbeltklik pa
Netvzerksforbindelser.

. Dobbeltklik pa

LAN-forbindelse.

. Klik p&4 Egenskaber.
. Klik pa Konfigurer.
. Klik p& fanen Stremstyring,

og marker derefter
afkrydsningsfeltet Tillad,

at denne enhed szetter
computeren ud af standby.

Vejledning til fejlfinding
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Fejlfinding uden diagnose

Afhjzelpning af netvaerksproblemer (Fortsat)

Problem

Arsag

Lesning

Netvaerksdriveren
kan ikke finde

netvaerkscontrolleren.

Netvaerkscontrolleren
er deakfiveret.

1. Ker programmet til opsaetning
af computeren, og aktiver
netvaerkscontrolleren.

2. Aktiver netvaerkscontrolleren
i operativsystemet via
Enhedshandtering.

Forkert netvaerksdriver.

Se dokumentationen til
netvaerkscontrolleren vedrerende
den korrekte driver, eller hent den
nyeste driver p& producentens
hjemmeside.

Lampen for
netvaerksstatusforbindelse
blinker aldrig.

@, Lysdioden for
netvaerksstatus skal
blinke, nér der
er akfivitet p&
netvaerket.

Der er ikke fundet et aktivt
netvaerk.

Kontrollér kabelferingen og
netvaerksudstyret for korrekt
tilslutning.

Netvaerkscontrolleren
er ikke indstillet korrekt.

Kontroller enhedens status i Windows,
se f.eks. i Enhedshandtering, om

driveren er indlaest og status for den
aktuelle netvaerksforbindelsesapplet

i Windows.

Netvaerkscontrolleren
er deakfiveret.

1. Ker programmet til opsaetning
af computeren, og aktiver
netvaerkscontrolleren.

2. Aktiver netvaerkscontrolleren
i operativsystemet via
Enhedshandtering.

Netvaerksdriveren er
ikke indlaest korrekt.

Geninstaller netveerksdriverne.
Se Vejledning til
netvaerkskommunikation

pd& dokumentations-cd’en.

Systemet kan ikke foretage
autosense for netvaerket.

Deaktiver autosense-egenskaberne,
og tving systemet ind i den korrekte
driftstilstand. Se Vejledning til
netvaerkskommunikation pa
dokumentations-cd’en.
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Fejlfinding uden diagnose

Afhjzelpning af netvaerksproblemer (Fortsat)

Problem

Arsag

Lesning

Diagnosticeringen melder
om fejl.

Kablet er ikke tilsluttet
korrekt.

Serg for, at kablet sidder korrekt

i netvaerksstikket, og at den anden
ende af kablet er tilsluttet den
korrekte enhed.

Kablet er sat i det
forkerte stik.

Serg for, at kablet er tilsluttet
det korrekte stik.

Der er et problem med
kablet eller enheden i

den anden ende af kablet.

Serg for, at kablet eller enheden
i den anden ende fungerer korrekt.

Netvaerkscontrollerens
interrupt deles med
et udvidelseskort.

Skift indstillinger for kortets
ressourcer i menuen Avanceret
i computerens opsaetningsprogram.

Netvaerkscontrolleren
er beskadiget.

Kontakt en autoriseret
tienesteudbyder.

Diagnosticeringen
melder ikke om fejl,
men computeren
kommunikerer ikke
med netvaerket.

Netvaerksdriverne er
ikke indlzest, eller
driverparametrene
passer ikke til den
aktuelle konfiguration.

Serg for, at netveerksdriverne

er indleest, og at driverparametrene
passer til konfigurationen

for netvaerkscontrolleren.

Kontrollér, at den rigtige

netvaerksklient og -protokol
er installeret.

Netvaerkscontrolleren
er ikke konfigureret
til denne computer.

Veelg ikonet Netvaerk
i Kontrolpanel, og
konfigurer netvaerkscontrolleren.

Netvaerkscontrolleren
holdt op med at fungere,
da der blev fojet et
udvidelseskort til
computeren.

Netvaerkscontrollerens
interrupt deles med
et udvidelseskort.

Skift indstillinger for kortets
ressourcer i menuen Advanced
i computerens opsaetningsprogram.

Netvaerkscontrolleren
kraever drivere.

Kontrollér, at driverne ikke blev
slettet ved et uheld, da driverne
il det nye udvidelseskort blev
installeret.

Vejledning til fejlfinding
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Afhjzelpning af netvaerksproblemer (Fortsat)

Problem

Arsag

Lesning

Netvaerkscontrolleren
holdt op med at fungere,
da der blev fojet et
udvidelseskort til
computeren.

(fortsat)

Det installerede
udvidelseskort er
et netvaerkskort og

i konflikt med det

infegrerede netvaerkskort.

Skift indstillinger for kortets
ressourcer i menuen Advanced
i computerens opsaetningsprogram.

Netvaerkscontrolleren
holder op med at fungere

uden nogen synlig arsag.

Filerne, der indeholder
netvaerksdriverne,
er beskadiget.

Geninstaller netvaerksdriverne
ved hjzelp af Restore Plus!.

Kablet er ikke filsluttet
korrekt.

Serg for, at kablet sidder korrekt
i netvaerksstikket, og at den
anden ende af kablet er tilsluttet
den korrekte enhed.

Netvaerkscontrolleren
er beskadiget.

Kontakt en autoriseret
tienesteudbyder.

Det nye netvaerkskort
vil ikke starte.

Det nye netvaerkskort
kan vaere defekt eller
opfylder méske ikke
industristandardens
specifikationer.

Installer et netvaerkskort, der opfylder
industristandarden, og som virker,
eller lad startsekvensen starte fra
en anden kilde.

Der kan ikke
etableres forbindelse
til netvaerksserveren
ved forseg pé
fierninstallation.

Netvaerkscontrolleren er
ikke konfigureret korrekt.

Kontroller netvaerkstilslutningen,

at en DHCP-server er til stede, og
at fiernsystemets installationsserver
indeholder driverne til netvaerkskortet.

Systemets
opsaetningsprogram
har rapporteret om en

uprogrammeret EEPROM.

Uprogrammeret EEPROM.

Kontakt en autoriseret
tienesteudbyder.
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Fejlfinding uden diagnose

Lesning af hukommelsesproblemer

Hyvis der opstar problemer med hukommelsen, kan du finde
nogle almindelige &rsager og lgsninger i tabellen nedenfor.

FORSIGTIG: HP understetter ikke en blanding af ECC- og
ikke-ECC-hukommelse pa systemer, der understatter ECC-hukommelse.
Ellers starter computeren ikke operativsystemet.

Afhjelpning af hukommelsesproblemer

Problem

Arsag

Lesning

Systemet genstarter ikke
eller fungerer ikke korrekt

efter installation af yderligere

hukommelsesmoduler.

Hukommelsesmodulet
er ikke den korrekte
type eller har ikke

den rette hastighed

til systemet, eller det

er ikke placeret korrekt.

Udskift modulet med en korrekt
enhed, der falger industristandarden
til computeren.

P& nogle modeller kan ECC- og
ikke-ECC-hukommelse ikke blandes.

Fejl pga. manglende
hukommelse.

Hukommelseskonfigurati
onen er muligvis ikke
indstillet korrekt.

Brug Enhedshéndtering
til at kontrollere
hukommelseskonfigurationen.

Der er ikke nok
hukommelse til at
kere programmet.

Kontrollér programdokumentationen
for at se kravet til hukommelse.

Hukommelsestest under

POST er ikke korrekt.

Hukommelsesmodulerne
er muligvis ikke
installeret korrek.

Kontroller, at hukommelsesmodu-
lerne er installeret korrekt, og at
de korrekte moduler bruges.

Integreret
grafik kan bruge
systemhukommelsen.

Kraever ingen handling.

Fejlmeddelelse om

utilstraekkelig hukommelse

under programudferelse.

Der er for mange
TSR-programmer
(Terminate and Stay
Resident) installeret.

Slet ungdvendige TSR-programmer.

Der er ikke nok
hukommelse til at
kere programmet.

Kontroller programmets krav
til hukommelse, eller tilfaj mere
hukommelse i computeren.
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Fejlfinding uden diagnose

Afhjelpning af hukommelsesproblemer (Fortsat)

Problem Arsag Lesning

Den rgde lysdiode for Hukommelsen er 1. Seet DIMM-modulerne i igen.
strem blinker fem gange installeret forkert Teend systemet.

pr. sekund, efterfulgt of eller fungerer ikke. 2 Udskift DIMM-modulerne et ad

en pause pd to sekunder,
og computeren bipper
fem gange.

gangen for at isolere det modul,
der ikke fungerer.

3. Udskift tredjepartshukommelse
med HP-hukommelse.

4. Udskift systemkortet.

Afhj=lpning af processorproblemer

Hvis der opstar processorproblemer, kan du finde nogle almindelige
arsager og Igsninger i tabellen nedenfor.

Afhjlpning af processorproblemer

Problem Arsag Lesning

Ydelsen er nedsat. Processoren er varm. 1. Kontroller, at luftstremmen til
computeren ikke er blokeret.

2. Kontroller, at ventilatorerne
er tilsluttet og fungerer korrekt
(visse ventilatorer fungerer kun,
nér der er behov for det).

3. Kontroller, at processorens
keglekappe er korrekt monteret.

Red lysdiode for stram Processoren er ikke 1. Kontroller, at processoren
blinker tre gange pr. korrekt placeret eller er monteret.
sekund, efterfulgt aof en ikke installeret. 2. Szt processoren i igen.

pause pé to sekunder.
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Afhjzelpning af cd-rom- og dvd-problemer

Hyvis der opstar problemer med cd-rom- eller dvd-drevet, kan du
se de almindelige arsager og lgsningerne i tabellen nedenfor eller

1 dokumentationen til enheden.

Afhjzlpning af cd-rom- og dvd-problemer

Problem

Arsag

Lesning

Systemet genstarter ikke fra

cd-rom- eller dvd-drevet.

Funktionen Removable
Media Boot er
deaktiveret

i computerens
opsaetningsprogram.

Kar computerens opsaetningsprogram,
og aktiver boot fra flytbart medie

i Storage > Storage Options.
Kontroller, at IDE CD-ROM er
aktiveret i Storage > Boot Order.

Netvaerksservertilstanden
er aktiveret

i computerens
opsaetningsprogram.

Ker computerens opsaetningsprogram,
og deaktiver Network Server Mode
i Security > Password Options.

Der sidder en cd, der ikke
kan startes fra, i drevet.

Saet en cd, der kan startes fra,
i drevet.

Startraekkefelgen
er ikke korrekt.

Kar computerens opsaetningsprogram,
og rediger startsekvensen i
Storage > Boot Order.

Cd-rom- eller
dvd-enhederne kan

ikke findes, eller driveren
er ikke indlzest.

Drevet er ikke tilsluttet
eller konfigureret
korrekt.

Se i dokumentationen til enheden.

Filmen kan ikke afspilles
i dvd-drevet.

Filmen har muligvis
en anden landekode.

Se i dokumentationen til dvd-drevet.

Der er ikke installeret
et dekoderprogram.

Installér et dekoderprogram.

Beskadiget medie.

Udskift mediet.

Filmenstilladelsesniveau
er 1&st via
foraeldrekontrollen.

Brug dvd-software il at fjerne lasen.

Mediet er lagt forkert
i drevet.

Seet mediet i igen.
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Fejlfinding uden diagnose

Afhjzelpning af cd-rom- og dvd-problemer (Fortsat)

Problem

Arsag

Lesning

Cd’en kan ikke udskydes
(skuffe).

Cd’en sidder ikke

korrekt i drevet.

Sluk computeren, og saet en tynd
metalstang ind i nedudskydningshullet,
og tryk til. Traek langsomt skuffen ud
af drevet, indtil den er helt ude, og
tag derefter cd’en ud.

Cd-rom-, cd-rw-, dvd-rom-

eller dvd-r/rw-drevet kan
ikke laese en disk eller er
leenge om at starte.

Mediet vender forkert.

Indseet mediet igen med etiketten
opad.

Dvd-rom-drevet er
leengere om at starte,
fordi det forst skal
fastsla, hvilken type
medie der afspilles,

f.eks. lyd eller billede.

Vent mindst 30 sekunder pg,

at dvd-drevet finder ud of, hvilken
medietype der afspilles. Laes de
andre lesningsforslag i dette emne,
hvis drevet stadig ikke starter.

Cd’en eller dvd’en

er snavset.

Renger cd’en eller dvd’en med
et cd-rensesaet, som kan kabes
i de fleste computerforretninger.

Windows kan ikke
finde cd-rom- eller
dvd-rom-drevet.

1. Brug Enhedshéndtering fil
at fierne eller afinstallere
den pagaldende enhed.

2. Genstart computeren, og
lad Windows finde cd- eller

dvd-driveren.

Det er vanskeligt eller
umuligt at breende
musik-cd’er.

Der benyttes et forkert
medie, eller mediets
kvalitet er for ringe.

1. Forseg at optage med en lavere
hastighed.

2. Kontroller, at du bruger det
rigtige medie til drevet.

3. Forsgg med et medie of et
andet maerke. Kvaliteten varierer
fra producent til producent.
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Afhjzelpning af drevkodeproblemer

Hyvis der opstar problemer med drevkoden, kan du finde
nogle almindelige &rsager og lgsninger i tabellen nedenfor.

Afhjelpning af drevkodeproblemer

Problem Arsag Lesning

Drevkoden ses ikke som et Drevbogstavet efter Velg et andet standarddrevbogstav
drevbogstav i Windows XP.  det sidste fysiske drev til drevkode i Windows XP.
er ikke tilgaengeligt.

Computeren startes fra Der kan startes Installer farst drevkoden, ndr
MS-DOS, efter at der fra drevkoden. operativsystemet er startet.
er lavet en drevkode,

der kan startes fra.

Losning af problemer med at fa adgang
til internettet

Henvend dig til internetudbyderen, eller se de almindeligste arsager
og lgsninger i tabellen nedenfor, hvis der opstar problemer med adgangen
til internettet.

Lesning af problemer med at fa adgang til internettet

Problem Arsag Lesning
Der kunne ikke oprettes Kontoen hos din Kontroller internetindstillingerne,
forbindelse til internettet. internetudbyder er ikke  eller kontakt udbyderen for at
konfigureret korrekt. f& hjeelp.
Modemet er ikke Tilslut modemet igen. Kontroller,
sat korrekt op. at tilslutningerne er korrekte ved
hjeelp af dokumentationen Hurtig
opsaetning.

Webbrowseren er ikke  Kontroller, at webbrowseren
konfigureret korrekt. er installeret og sat op til at
fungere med internetudbyderen.

Kablet/DSL-modemet Tilslut kablet/DSL-modemet.
er ikke filsluttet. En lysdiode for stram lyser pa
kabel/DSL-modemets forside.
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Lesning af problemer med at fa adgang til internettet (Fortsat)

Problem

Arsag

Lesning

Der kunne ikke oprettes
forbindelse til internettet.
(fortsat)

Kabel/DSL+jenesten er
ikke tilgaengelig eller er
blevet afbrudt pa grund
af dérlige vejrforhold.

Forseg at oprette forbindelse til
internettet p& et senere tidspunkt,
eller kontakt internetudbyderen.
(Hvis der er forbindelse fil
kabel/DSL+jenesten, lyser
lysdioden for forbindelse p&
kabel/DSL-modemets forside).

CAT5 UTP-kablet er
ikke filsluttet.

Tilslut CAT5 UTP-kablet mellem
kabelmodemet og computerens
RJ-45-stik. (Hvis der er forbindelse,
lyser lysdioden for pc’en pa
kabel/DSL-modemets forside).

IP-adressen er ikke
konfigureret korrekt.

Kontakt internetudbyderen for
at f& oplyst den rette IP-adresse.

Cookies er beskadigede.

(En “cookie” er en lille
maengde oplysninger,
som en webserver kan
gemme midlertidigt

i webbrowseren. Det
er nyttigt at bevare
specifikke oplysninger,
som webserveren
derefter kan hente

pd et senere tidspunkt).

| Windows XP:
1. Veelg Start > Kontrolpanel.

2. Dobbeltklik pa
Internetindstillinger.

3. Klik pa knappen Slet cookies
under fanen Generelt.

Internetprogrammer kan
ikke startes automatisk.

Visse programmer
kan ferst startes, ndr
du er logget p& hos
internetudbyderen.

Log pd hos internetudbyderen,
og start det enskede program.
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Fejlfinding uden diagnose

Lesning af problemer med at fa adgang til internettet (Fortsat)

Problem

Arsag

Lesning

Der kunne ikke oprettes
forbindelse til internettet.
(fortsat)

Kabel/DSL+jenesten er
ikke tilgaengelig eller er
blevet afbrudt pa grund
af dérlige vejrforhold.

Forseg at oprette forbindelse til
internettet p& et senere tidspunkt,
eller kontakt internetudbyderen.
(Hvis der er forbindelse fil
kabel/DSL+jenesten, lyser
lysdioden for forbindelse p&
kabel/DSL-modemets forside).

CAT5 UTP-kablet er
ikke filsluttet.

Tilslut CAT5 UTP-kablet mellem
kabelmodemet og computerens
RJ-45-stik. (Hvis der er forbindelse,
lyser lysdioden for pc’en pa
kabel/DSL-modemets forside).

IP-adressen er ikke
konfigureret korrekt.

Kontakt internetudbyderen for
at f& oplyst den rette IP-adresse.

Cookies er beskadigede.

(En “cookie” er en lille
maengde oplysninger,
som en webserver kan
gemme midlertidigt

i webbrowseren. Det
er nyttigt at bevare
specifikke oplysninger,
som webserveren
derefter kan hente

pd et senere tidspunkt).

| Windows XP:
1. Veelg Start > Kontrolpanel.

2. Dobbeltklik pa
Internetindstillinger.

3. Klik pa knappen Slet cookies
under fanen Generelt.

Internetprogrammer kan
ikke startes automatisk.

Visse programmer
kan ferst startes, ndr
du er logget p& hos
internetudbyderen.

Log pd hos internetudbyderen,
og start det enskede program.
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Lesning af problemer med at fa adgang til internettet (Fortsat)

Problem Arsag Lesning

Internettet er for lenge om  Modemet er ikke sat Kontroller, at den korrekte

at overfere websteder. korrekt op. modemhastighed og COM-port
er valgt.
| Windows XP:

1. Veelg Start > Kontrolpanel.

2. Dobbeltklik p& System.

3. Klik p& fanen Hardware.

4. Klik p& knappen
Enhedshéandtering

i omradet Enhedshandtering.

5. Dobbeltklik p& Porte
(COM & LPT).

6. Hajreklik pa den COM-port,
som modemet benytter, og

klik derefter p& Egenskaber.

7. Kontroller under Enhedsstatus,
at modemet fungerer korrekt.

8. Kontroller under Brug af
enheden, at modemet
er aktiveret.

9. Klik p& knappen Feijlfind, og
felg vejledningen pa skaermen,
hvis der er flere problemer.
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Afhjzelpning af problemer med software

De fleste softwareproblemer opstéar pa grund af fglgende:

Programmet blev ikke installeret eller konfigureret korrekt.

Der er ikke nok hukommelse til at kgre programmet.

Der er en programkonflikt.

S¢rg for, at alle ngdvendige enhedsdrivere er installeret.

Hyvis du har installeret et andet operativsystem end det, der var
installeret fra fabrikken, skal du kontrollere, at det understgttes

af dit system.

Kgr om muligt hjelpeprogrammet Configuration Record for at finde
ud af, om der er foretaget @ndringer i softwaren, som kan vere skyld
i problemerne. Se under afsnittet “Hjalpeprogrammet Configuration
Record” i denne vejledning for at fa flere oplysninger.

Hvis der opstar softwareproblemer, kan du finde mulige 1gsninger
i nedenstaende tabel.

Afhjzelpning af softwareproblemer

Problem

Arsag

Lesning

Computeren fortseetter ikke,
og der vises intet HP-logo
pd skaermen.

Der opstod en POST-ejl.

Hold aje med biplyde og
lysdiodernes signaler pé
computerens forside.

Se Appendiks A,
“POSTHejlmeddelelser” for

at finde de mulige érsager.

Se vilkar og betingelser i Restore Kit
eller i den verdensomspaendende
begraensede garanti.

Computeren fortszetter ikke,
efter at HP-logoet har vaeret
vist p& skaermen.

Systemfilerne er muligvis
beskadigede.

Brug genoprettelsesdisketten til at
gennemsege harddisken for fejl.
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Afhjzlpning af softwareproblemer (Fortsat)

Problem Arsag Lesning
Der vises en meddelelse Den software, der Kontroller, at softwaren er godkendt
om, at der er foretaget benyttes, er ikke af Microsoft til den pageeldende
en ugyldig handling. godkendt af Microsoft  version af Windows (disse oplysninger
til den pégaeldende findes p& programpakken).
version af Windows.
Konfigurationsfilerne Gem alle data, luk alle programmer,
er beskadiget. og genstart computeren, hvis det
er muligt.

Kontakt kundesupport

Kontakt en autoriseret forhandler eller serviceudbyder for at fa hjelp
og vejledning. Besgg www.hp.com for at finde en forhandler eller
serviceudbyder i nzrheden.

% Hvis du indleverer computeren til service hos en autoriseret
forhandler eller serviceudbyder, skal du huske at udlevere
adgangskoderne for start og ops&tning, hvis de er defineret.

% Se nummeret, der er anfgrt i garantien, eller i vejledningen
Telefonnumre til teknisk support pa dokumentations-cd’en
for at f oplysninger om teknisk support.
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POST-fejimeddelelser

Dette appendiks handler om de fejlkoder, fejlmeddelelser og forskellige
indikatorlysdioder og lydalarmer, der muligvis fremkommer under
POST (Power-On Self-Test) eller computergenstart, de mulige arsager
til problemet, og hvad du kan ggre for at udbedre fejlene.

Deaktivering af POST-meddelelser undertrykker de fleste
systemmeddelelser under POST, f.eks. optelling af hukommelsen

og tekstmeddelelser, der ikke omhandler fejl. Hvis der opstér en
POST-fejl, vises fejlmeddelelsen pa skermen. Du kan manuelt skifte
til aktivering af POST-meddelelser ved at trykke pa en vilkarlig tast
(undtagen F10 og F12). Standarden er deaktivering af POST-meddelelser.

Hastigheden for indl@sning af operativsystemet og omfanget af tests
bestemmes af valget af POST-tilstand.

Quick Boot er en hurtig startproces, der ikke kgrer alle test
pa systemniveau, f.eks. hukommelsestest. Full Boot kgrer alle
ROM-baserede systemtests og tager lengere tid at udfgre.

Full Boot kan ogsa aktiveres til at kgre regelmassigt fra hver dag

til hver 30 dag i en planlagt periode. Rekonfigurér computeren til
Full Boot hver x. dag ved hjelp af computerens opsa@tningsprogram,
hvis du vil oprette en tidsplan.

Se opsetningsvejledningen (F10) pa dokumentations-cd’en for
at fa flere oplysninger om computerens opsa@tningsprogram.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Numeriske POST-koder og tekstmeddelelser

Dette afsnit beskriver de POST-fejl, hvortil der er knyttet numeriske
koder. Dette afsnit indeholder desuden en raekke tekstmeddelelser,
der muligvis vises under POST.

% Computeren bipper en gang, efter en POST-tekstmeddelelse vises
pa skaermen.

Numeriske koder og tekstmeddelelser

Kode/Meddelelse Mulig arsag Anbefalet handling

101-Option ROM Systemhukommelsens 1. Bekreeft, at ROM’en er korrekt.

Checksum Error eller udvidelseskortets 2. Flash ROM'en, hvis det er nadvendigt.
indstilling for '

3. Hvis der for nylig er tilfzjet et
udvidelseskort, skal det fjernes for
at konstatere, om det er &rsagen
til problemet.

4. Ryd CMOS. (Se ogsa Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.")

5. Hvis meddelelsen forsvinder,
er der muligvis et problem
med udvidelseskortet.

6. Udskift systemkortet.

hukommelseschecksum.

102-System Board DMA eller timere. 1. Ryd CMOS. (Se ogsé& Appendiks B,
Failure “Sikkerhed med adgangskode
og nulstilling af CMOS.")

2. Fjern alle udvidelseskort.
3. Udskift systemkortet.

103-System Board DMA eller timere. 1. Ryd CMOS. (Se ogsé& Appendiks B,
Failure “Sikkerhed med adgangskode
og nulstilling af CMOS.”)

2. Fjern alle udvidelseskort.
3. Udskift systemkortet.

A-2 www.hp.com Veijledning til fejlfinding



POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

110-Out of Memory
Space for Option
ROMs

Et PCl-udvidelseskort,

der for nylig er installeret,

indeholder en ekstra
ROM, der er for stor
til at kunne overfares

via POST.

1. Hvis der for nylig er tilfajet et
PCl-udvidelseskort, skal det fjernes
for at konstatere, om det er drsagen
til problemet.

2. Gé ind i computerens
opsaetningsprogram, og indstil
Advanced > Device Options >
NIC PXE Option ROM
Download til DISABLE for at
forhindre, at PXE-indstillingen ROM
for det interne netvaerkskort overfares
under POST, s& der frigares mere
hukommelse til et udvidelseskorts
ekstra ROM. Den interne PXE-indstilling
ROM bruges til at genstarte fra
netvaerkskortet til en PXE-server.

3. ACPI/USB Buffers ved Top
of Memory i computerens
opsaetningsprogram
(aktiveret/deaktiveret).

150-SafePost Active

Et PCl-udvidelseskort

reagerer ikke.

1. Genstart computeren.
2. Deaktivér SafePost.

3. Hvis udvidelseskortet ikke reagerer,
skal det udskiftes.

162-System Options
Not Set

Konfigurationen
er forkert.

Batteriet til realtidsuret
skal muligvis skiftes.

Ker computerens opsaetningsprogram,
og kontroller konfigurationen under
Advanced > Onboard Devices.

Stil dato og klokkeslzet i Kontrolpanel.
Hvis problemet fortsaetter, skal

du udskifte batteriet til realtidsuret.

Se Hardwarevejledningen pa
dokumentations-cd’en for at f& en
vejledning i issetning af et nyt batteri,
eller kontakt en autoriseret forhandler
for at f& udskiftet batteriet fil realtidsuret.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

163-Time & Date
Not Set

Ugyldig dato
eller klokkeslaet i
konfigurations-
hukommelsen.

Batteriet til realtidsuret
skal muligvis udskiftes.

Nulstil dato og klokkeslaet under
Kontrolpanel (computerens
opsaetningsprogram kan ogsd bruges).
Hvis problemet fortsaetter, skal

du udskifte batteriet til realtidsuret.

Se Hardwarevejledningen pa
dokumentations-cd’en for at f& en
vejledning i issetning af et nyt batteri,
eller kontakt en autoriseret forhandler
for at f& udskiftet batteriet til realtidsuret.

CMOS-jumperen er
muligvis ikke korrekt
placeret.

Kontrollér eventuelt, om CMOS-jumperen
sidder rigtigt.

164-Memory Size Hukommelsens sterrelse  Tryk péa tasten F1 for at gemme
Error er endret siden den endringerne af hukommelsen.
seneste start (der er
tilfajet eller fiernet
hukommelse).
Hukommelsen er 1. Ker computerens opsaetningsprogram
konfigureret forkert. eller et Windows-hjzelpeprogram.
2. Kontroller, at hukommelsesmodulerne
er installeret korrekt.
3. Ker testen med hukommelse
fra HP alene, hvis der er tilfajet
hukommelse fra en anden leverander.
4. Kontrollér, at du bruger den
rigtige type hukommelsesmodul.
A-4 www.hp.com Veijledning til fejlfinding



POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig arsag

Anbefalet handling

201-Memory Error

RAMAejl.

1. Ker computerens opsaetningsprogram
eller et Windows-hjzelpeprogram.

2. Kontroller, athukommelsesmodulerne
er installeret korrekt.

3. Kontrollér, at du bruger den
rigtige type hukommelsesmodul.

4. Fjern og udskift hukommelsesmodulerne
et ad gangen for at finde det fejlramte
modul.

5. Udskift de fejlramte

hukommelsesmoduler.

6. Hvis fejlen ikke er afhjulpet, nar
hukommelsesmodulerne er udskiftet,
skal systemkortet udskiftes.

202-Memory Type
Mismatch

Hukommelsesmodulerne
passer ikke til hinanden.

Udskift hukommelsesmodulerne,
s& de passer sammen.

213-Incompatible
Memory Module
in memory Socket(s)

X, X, ...

Et hukommelsesmodul

i hukommelsesstikket,
der er angivet i
fejlmeddelelsen, mangler
vigtige SPD-oplysninger
eller er inkompatibelt
med chipsaettet.

1. Kontrollér, at du bruger den rigtige
type hukommelsesmodul.

2. Prev et andet hukommelsesstik.

3. Udskift DIMM-modulet med ét,
der overholder SPD-standarden.

214-DIMM
Configuration
Warning

Der er opstdet

en specifik fejl i en
hukommelsesenhed,
der er installeret i det
identificerede stik.

1. Kontrollér, at du bruger den
rigtige type hukommelsesmodul.

2. Prov et andet hukommelsesstik.

3. Udskift hukommelsesmodulet,
hvis problemet fortsaetter.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig arsag

Anbefalet handling

219-ECC Memory
Module Detected
ECC Modules not
supported on this
Platform

Hukommelsesmoduler,
der er tilfgjet for nylig,
understetter fejlretning

af ECC-hukommelsen.

1.

Hvis der for nylig er tilfgjet ekstra
hukommelse, skal den fjernes for
at se, om problemet fortsaetter.

. Se i produktdokumentationen for

at f& oplysninger om understettelse
af hukommelse.

301-Keyboard Error

Tastaturfejl.

. Tilslut tastaturet igen, mens

der er slukket for computeren.

. Kontrollér stikket for bgjede

eller manglende ben.

. Kontrollér, at der ikke er taster,

der er trykket ned.

. Udskift tastaturet.

303-Keyboard
Controller Error

|/Oxkortets
tastaturcontroller.

. Tilslut tastaturet igen, mens

der er slukket for computeren.

. Udskift systemkortet.

304-Keyboard or
System Unit Error

Tastaturfejl.

. Tilslut tastaturet igen, mens

der er slukket for computeren.

. Kontrollér, at ingen taster

er trykket ned.

. Udskift tastaturet.
. Udskift systemkortet.

404-Parallel Port
Address Conflict
Detected

B&de den eksterne og
den interne port er tildelt
den parallelle port X.

J—

. Fijern alle kort til udvidelse

af parallelporten.

. Ryd CMOS. (Se ogsd Appendiks B,

“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

. Rekonfigurér kortressourcerne,

og/eller ker computerens
opsatningsprogram.

A-6
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

410-Audio Interrupt
Conflict

Der er opstdet en konflikt
mellem IRQ-adressen
og en anden enhed.

Ker computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

411-Network
Interface Card
Interrupt Conflict

Der er opstaet en konflikt
mellem IRQ-adressen
og en anden enhed.

Kar computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

501-Display Adapter

Failure

Grafikcontrolleren.

1. Saet grafikkortet i igen, (hvis det
er relevant).

2. Ryd CMOS. (Se ogsé Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

3. Bekraeft, at skeermen er tilsluttet
og teendt.

4. Seet grafikkortet i igen (hvis det
er muligt).

510-Splash Screen
Image Corrupted

Velkomstbilledet
indeholder fejl.

Installér den seneste version af
ROMPaq for at gendanne billedet.

511-CPU, CPUA,
or CPUB Fan not
Detected

CPU-ventilatoren er ikke
tilsluttet eller fungerede

ikke korrekt.

1. Installer CPU-ventilatoren igen.

. Installer ventilatorkablet igen.

512-Chassis, Rear
Chassis, or Front
Chassis Fan not
Detected

Kabinettets ventilator,
bag pd kabinettet

eller foran pé& kabinettet,
er ikke tilsluttet eller
fungerede ikke.

2
3. Udskift CPU-ventilatoren.
1

. Installer kabinettets ventilator igen,
bag pé& kabinettet eller foran pé
kabinettet.

2. Installer ventilatorkablet igen.

3. Udskift kabinettets ventilator, bag pé
kabinettet eller foran pa kabinettet.

514-CPU or Chassis
Fan not Detected

CPU- eller
kabinetventilatoren

er ikke tilsluttet eller
fungerede ikke korrekt.

1. Installer CPU- eller
kabinetventilatoren igen.

2. Installer ventilatorkablet igen.
3. Udskift CPU- eller kabinetventilatoren.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

601-Diskette

Controller Error

Der er fejl i
ledningsnettet til
diskettecontrolleren
eller diskettedrevet.

1.
2.
3.

Kar computerens opsaetningsprogram.
Kontrollér og/eller udskift kablerne.

Ryd CMOS. (Se ogsé& Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

. Udskift diskettedrevet.
. Udskift systemkortet.

605-Diskette Drive
Type Error

Uoverensstemmelse
i drevtypen.

N — | O N

. Ker computerens opsaetningsprogram.

. Afbryd alle andre diskettecontroller-

enheder (banddrev).

. Ryd CMOS. (Se ogsé& Appendiks B,

“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

610-External Storage
Device Failure

Det eksterne banddrev
er ikke ftilsluttet.

Installér banddrevet igen, eller tryk
pé F1, og lad systemet rekonfigurere
uden drevet.

611-Primary Floppy
Port Address
Assignment Conlflict

Konfigurationsfejl.

Ker computerens opsaetningsprogram,
og kontroller konfigurationen under
Advanced > Onboard Devices.

660-Display cache is
detected unreliable

Den integrerede
grafikcontrollers
skaermcache fungerer
ikke korrekt og
deaktiveres.

Udskift systemkortet, hvis minimal
forringelse af grafikken er et problem.

912-Computer Cover
Has Been Removed
Since Last System
Startup

Computerens daekplade

har veeret fjernet siden
sidste systemstart.

Kraever ingen handling.

1. Tilslut eller udskift I&semekanismen.

914-Hood Lock Coil

is not Connected

Smart Cover-
l&semekanismen mangler

. ' 2. Iszet eller udskift I&semekanismens
eller er ikke tilsluttet.

kabel.

A-8 Veijledning til fejlfinding
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POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

916-Power Button
Not Connected

Afbryderknappens
ledningsnet er lasnet eller
fiernet fra bundkortet.

Tilslut eller monter afbryderknappens
ledningsnet igen.

917-Front Audio
Not Connected

Det forreste ledningsnet
til lyd er lasnet eller
fiernet fra bundkortet.

Tilslut eller monter det forreste ledningsnet
til lyd igen.

918-Front USB
Not Connected

Det forreste ledningsnet
til USB er lgsnet eller
fiernet fra bundkortet.

Tilslut eller monter det forreste ledningsnet
til USB igen.

919-Multi-Bay Riser
not Connected

Udvidelseskortet er
fiernet eller er ikke
korrekt geninstalleret
i systemet.

Seet udvidelseskortet i igen.

1151-Serial Port A
Address Conflict
Detected

B&de den eksterne
og den interne port
er tildelt til COM1.

1. Fjern alle kort til udvidelse of den
serielle port.

2. Ryd CMOS. (Se ogsé& Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.")

3. Rekonfigurérkortressourcerne, og/eller
kar computerens opsaetningsprogram
eller Windows-hjzelpeprogrammerne.

1152-Serial Port B
Address Conflict
Detected

Bé&de den eksterne og
den interne port er tildelt
til COM2.

1. Fjern alle kort til udvidelse af den
serielle port.

2. Ryd CMOS. (Se ogs& Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.”)

3. Rekonfigurér kortressourcerne,
og/eller ker computerens
opsaetningsprogram eller
Windows-hjzelpeprogrammerne.

Vejledning til fejlfinding
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

1155-Serial Port
Address Conflict
Detected

Ba&de den eksterne
og den interne port er
tildelt fil samme IRQ.

1. Fjern alle kort til udvidelse af den
serielle port.

2. Ryd CMOS. (Se ogsé Appendiks B,
“Sikkerhed med adgangskode
og nulstilling af CMOS.")

3. Rekonfigurér kortressourcerne,
og/eller ker computerens
opsaetningsprogram eller
Windows-hjaelpeprogrammerne.

1201-System Audio
Address Conflict
Detected

Der er opstdet en
konflikt mellem enhedens
IRQ-adresse og en anden

enhed.

Kar computerens opsaetningsprogram,
og nulstil RQ under Advanced >
Onboard Devices.

1202-MIDI Port
Address Conflict
Detected

Der er opstéet en
konflikt mellem enhedens
IRQ-adresse og en anden

enhed.

Ker computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

1203-Game Port
Address Conflict
Detected

Der er opstéet en
konflikt mellem enhedens
IRQ-adresse og en anden

enhed.

Ker computerens opsaetningsprogram,
og nulstil IRQ under Advanced >
Onboard Devices.

1720-SMART Hard
Drive Detects
Imminent Failure

Der er ved at opsta

en fejl p& harddisken.
Nogle harddiske har en
firmwareprogramrettelse
til harddisken, der retter

en fejlagtig fejlmeddelelse.

1. Find ud af, om harddisken giver
korrekte fejlmeddelelser. Kar
computerens opsaetningsprogram,
og ker testen Drive Protection System
under Storage > DPS Self-test.

2. Anvend firmwareprogramrettelsen til
harddisken, hvis det er relevant.
(Findes p& www.hp.com/support).

3. Sikkerhedskopiér indholdet, og udskift
harddisken.

www.hp.com Veijledning til fejlfinding
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig arsag

Anbefalet handling

1785-Multibay

incorrectly installed

(til Multibay som option/
ikke-USDT-systemer)

1. Multibay-tilbeharets
fladkabler er ikke
korrekt placeret eller
fastgjorte.

2. Multibay-enheden er
ikke placeret korrekt.

3. Multibay-diskette
til stede.

1.

Kontroller, at Multibay-tilbeheret er
fastgjort som enhed O til IDE-kablet.

. Kontroller, at ingen anden enhed er

fastgjort til det samme IDE-kabel.

. Kontroller, at begge ender af IDE- og

Multibay-fladkablerne er placeret
korrekt.

. Kontroller, at Multibay-enheden

er sat helt i.

. Kontroller, at der ikke sidder

en Multibay-diskette i
(Multibay-diskettedrev understattes
ikke af Multibay-tilbehgret).

(integrerede Multibay/
USDT-systemer)

1. Multibay-enheden er
ikke placeret korrekt.

2. Multibay-udvidelseskort
et er ikke placeret
korrekt.

. Kontroller, at Multibay-enheden

er sat helt i.

. Kontroller, at Multibay- udvidelseskortet

er korrekt monteret.

1794-Inaccessible
devices attached to
SATA 1 and/or
SATA 3

(systemer med 4

SATA-porte)

En enhed er fastgjort til
SATA 1 og/eller SATA 3.
Enheder, der er fastgjort
til disse stik, er ikke
tilgeengelige, nar “SATA
Emulation” er indstillet

til “Combined IDE
Controller” i computerens
opsaetningsprogram.

. Hvis du kerer Windows 2000 eller

Windows XP, skal du aendre “SATA
Emulation” til “Separate IDE Controller”
i computerens opsaetningsprogram.

. Hvis du ikke kerer Windows 2000

eller Windows XP, skal du flytte
de pégaeldende enheder til SATA O
eller SATA 2 (hvis muligt).

. Fiern de pégzeldende enheder

fra SATA 1 og SATA 3.

Vejledning til fejlfinding
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig arsag Anbefalet handling

1794-Inaccessible

device atftached

En enhed er fastgjort il
SATA 1. Enheder, der

1.

Hvis du kerer Windows 2000 eller
Windows XP, skal du sendre “SATA

to SATA 1 er fastgjort til dette stik, Emulation” til “Separate IDE Controller”
(systemer med 2 er ikke tilgaengelige, i computerens opsaetningsprogram.
SATA-porte) ndr “SATA Emulation” 2. Hvis du ikke kerer Windows 2000

er indstillet til “Combined
IDE Controller”

i computerens
opsaetningsprogram.

eller Windows XP, skal du flytte
den pégaeldende enhed til SATA O
(hvis muligt).

. Fiern den pégeeldende enhed fra

SATA 1.

1796-SATA Cabling

Error

En eller flere
SATA-enheder er forkert
fastgjorte. Der opnas
optimal ydeevne, hvis
SATA 0O- og SATA
1-stikkene bruges fer
SATA 2 og SATA 3.

Kontroller, at SATA-stikkene bruges

i opadgéende raekkefglge. Til én enhed
skal du bruge SATA 0. Brug SATA O

og SATA 1 til to enheder. Brug SATA 0O,
SATAT og SATA 2 til tre enheder.

1800-Temperature
Alert

Den interne temperatur
overstiger
specifikationerne.

. Kontrollér, at computerens

ventilationshuller ikke er blokeret, og
at processorens kaleventilator kerer.

. Bekraeft valget af processorhastighed.
. Udskift processoren.
. Udskift systemkortet.

1801-Microcode
Patch Error

Processoren understgttes
ikke aof ROM BIOS’en.

- N WO N

2.

. Opgradér BIOS’en til en korrekt

version.

Udskift processoren.

1998-Master Boot

Record has been Lost

Den sikkerhedskopi,
der tidligere blev gemt
af MBR, er beskadiget.

Kar computerens opsaetningsprogram, og
gem MBR’en for den disk, der startes fra.

www.hp.com
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Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse

Mulig érsag

Anbefalet handling

1999-Master Boot
Record has Changed

Den aktuelle MBR svarer

ikke til den kopi af
MBR’en, der tidligere

blev gemt.

Vaer meget forsigtig! MBR’en er
muligvis opdateret pga. normale
diskvedligeholdelsesaktiviteter
(Disk Manager, fdisk eller format).

A Erstattes den i denne situation med
en MBR, der tidligere blev gemt,
kan det medfere tab aof data.
Hvis du er sikker pd, at aendringen
af MBR’en er utilsigtet og uensket,
f.eks. pga. virus, skal du kere
computerens opsaetningsprogram
og gendanne den kopi af MBR,
der tidligere blev gemt. Ker i modsat
fald computerens opsaetningsprogram,
og deaktiver MBR-sikkerheden, eller
gem MBR’en for den disk, der startes fra.

2000-Master Boot
Record Hard Drive
has Changed

Den harddisk, der

i ojeblikket startes fra,
er ikke den samme
som dengang,
MBR-sikkerheden

blev aktiveret.

Kar computerens opsaetningsprogram,
og deaktivér MBR-sikkerheden, eller
gem MBR’en for den disk, der startes fra.

Ugyldigt elektronisk

serienummer

Det elektroniske
serienummer er

beskadiget.

1. Ker computerens opsaetningsprogram.
Hvis programmet til opsaetning af
computeren allerede indeholder data
i feltet eller ikke tillader angivelse
af serienummeret, skal du hente
og kereSP5572 EXE (SNZERO.EXE),
som du finder p& www.hp.com.

2. Ker computerens opsaetningsprogram,
og forseg at indtaste serienummeret
under Security, System ID, og gem
derefter aendringerne.

Vejledning til fejlfinding

www.hp.com


http://www.hp.com

POST-ejlmeddelelser

Numeriske koder og tekstmeddelelser (Fortsat)

Kode/Meddelelse Mulig arsag Anbefalet handling
Netvaerksservertilstand  Tastaturfejl, mens 1. Tilslut tastaturet igen, mens
aktiv, og intet tastatur  netveerksservertilstanden der er slukket for computeren.
er filsluttef er aktiveret. 2. Kontrollér stikket for bgjede

eller manglende ben.

3. Kontrollér, at ingen taster
er trykket ned.

4. Udskift tastaturet.

Paritetscheck 2

RAM-paritetsfejl. Ker computerens opsaetningsprogram
og diagnosticeringsprogrammerne.

Systemet starter ikke
uden en ventilator

CPU-ventilator er ikke 1. Abn léget, tryk p& afbryderen, og
installeret eller afbrudt kontroller, at processorens ventilator
i VSFF-kabinettet. drejer rundt. Hvis processorens

ventilator ikke drejer rundt, skal
du kontrollere, at ventilatorkablet
er tilsluttet systemkortets header.
Kontroller, at ventilatoren er
placeret eller installeret korrekt.

2. Hvis ventilatoren er tilsluttet og
placeret korrekt, men ikke drejer

rundt, skal du udskifte den.
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer
til POST-diagnosticering

SN

SN

Dette afsnit omhandler frontpanelets lysdiodekoder tillige med
hgrbare alarmer, der kan forekomme fgr eller under POST, men som
ikke ngdvendigvis er knyttet til en fejlkode eller tekstmeddelelse.

Hvis lysdioder blinker pa et PS/2-tastatur, skal du holde gje med
blinkende lysdioder pa computerens frontpanel og se i tabellen
nedenfor for at tolke frontpanelets lysdiodekoder.

De anbefalede handlinger i tabellen nedenfor er anfort 1 den rekkefglge,
som de skal udfgres i.

Frontpanelets lysdioder og herbare alarmer til diagnosticering

Aktivitet Bip Mulig éarsag Anbefalet handling

Den grenne Ingen  Computeren Ingen

lysdiode for er teendt.

strom lyser.

Den grenne Ingen  Computeren Ingen er p&kraevet. Tryk p&
lysdiode for stram er i Skift til en vilkérlig tast, eller flyt musen

blinker hvert andet
sekund.

RAMilstand (kun  for at vaekke computeren.
udvalgte modeller)

eller almindelig

standby.

Vejledning til fejlfinding

www.hp.com A-15



POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig éarsag Anbefalet handling

Red lysdiode for 2 Processorens 1. Serg for, at computerens

strem blinker to termiske ventilationshuller ikke er blokeret,

gange pr. sekund, beskyttelse og at processorens kgleventilator

efterfulgt of en er aktiveret: kerer.

pokusedpa fo En bleeser er . Abn laget, tryk pé afbryderen, og

sekunder. muligvis blokeret kontroller, at processorens ventilator
eller drejer ikke drejer rundt. Hvis processorens
rundt. ventilator ikke drejer rundt, skal
ELLER du kontrollere, at ventilatorkablet
Kelekappen/ Er hItSIUJtet s>;stemt|$|orttets header.
ventilatoren er lon ro terlllo Yer; '|T orteE er Kt
ikke monteret placeret eller installeret korrekt.
korrekt pa . Hvis processorventilatoren er tilsluttet
processoren. og placeret korrekt, men ikke drejer

rundt, skal du udskifte den.

. Saet processorens keleklap pé igen,
og kontroller, at ventilatoren er
monteret korrekt.

. Kontakt en autoriseret forhandler
eller serviceyder.

Red lysdiode for 3 Processoren er . Kontroller, at processoren

stram blinker tre

ikke installeret

er monteret.

gange pr. sekund, (angiver ikke _ Saet processoren i igen.
efterfulgt af en en beskadiget P 9
pause pé to processor).
sekunder.
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig éarsag Anbefalet handling
Red lysdiode for 4 Stremsvigt 1. Abn léget, og kontroller, at det
strem blinker fire (stremforsyningen fireledede stremforsyningskabel
gange pr. sekund, er overbelastet). er filsluttet stikket p& systemkortet.
efterfulgtoaf en 2. Kontroller, om en enhed forérsager
pause pd fo problemerne, ved at afbryde ALLE
sekunder. tilsluttede enheder (f.eks. harddisk,
diskettedrev eller optiske drev og
udvidelseskort). Taend systemet.
Hvis systemet skifter til POST, skal
du slukke og udskifte én enhed ad
gangen og gentage proceduren,
indtil fejlen forekommer. Udskift
den enhed, der forarsager fejlen.
Fortseet med ot tilfaje enhederne
én ad gangen for at sikre, at alle
enheder fungerer korrekt.
3. Udskift stremforsyningen.
4. Udskift systemkortet.
Red lysdiode for 5 Hukommelsesfeil 1. Seet DIMM-modulerne i igen.
strem blinker fem for videomodul. Taend systemet.
gange pr. sekund, 2. Udskift &t DIMM-modul ad gangen
efterfulgtuof en for at isolere det modul, der ikke
pakuse dPG fo fungerer.
sexunaer. 3. Udskift tredjepartshukommelse
med HP-hukommelse.
4. Udskift systemkortet.
Red lysdiode for 6 Grdfikfeil for Systemer med grafikkort:

stram blinker seks
gange pr. sekund,
efterfulgt af en
pause pa to
sekunder.

videomodul.

1.

2.
3.

Seet grafikkortet rigtigt i.
Teend systemet.

Udskift grafikkortet.
Udskift systemkortet.

Udskift systemkortet, hvis systemet
har et integreret grafikkort.

Vejledning til fejlfinding
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig éarsag Anbefalet handling
Red lysdiode for 7 Fejl pa Udskift systemkortet.
strem blinker syv systemkortet (fejl
gange pr. sekund, sporet i ROM fer
efterfulgt of en skaermmodulet).
pause pd to
sekunder.
Red lysdiode for 8 Ugyldig ROM . Flash ROM’en igen ved
strem blinker otte baseret pa forkert hjzelp aof en ROMPag-diskette.
gange pr. sekund, checksum. Se afsnittet “ROM Flash” i
efterfulgt of en Desktop Management Guide
pause pé& to p& dokumentations cd’en.
sekunder. . Udskift systemkortet.
Red lysdiode for 9 Systemet taender, . Kontroller, at spaendingsvaelgeren
strem blinker ni men kan ikke bag pé& stremforsyningen (p& visse
gange pr. sekund, starte. modeller) er angivet til den rette
efterfulgt af en speending. Den rette indstilling
pause pa to af spaendingen afhaenger af
sekunder. det aktuelle omréde.

. Udskift systemkortet.

. Udskift processoren.
Red lysdiode for 10 Forkert . Kontroller alle grafikkort ved at tage

strem blinker i
gange pr. sekund,
efterfulgt af en
pause pd to
sekunder.

tilbehgrskort.

kortet ud (ét ad gangen, hvis der er
flere kort), og teend systemet for at
se, om fejlen er rettet.

. Nér du har fundet det pagaeldende

kort, skal du tage det ud og
udskifte det.

. Udskift systemkortet.

www.hp.com
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POST-ejlmeddelelser

Frontpanelets lysdioder og herbare alarmer til diagnosticering (Fortsat)

Aktivitet Bip Mulig éarsag Anbefalet handling

Systemet Ingen  Systemet kunne Tryk p& og hold afbryderen nede i mindre
teendes ikke, ikke teendes. end fire sekunder. Hvis harddiskens

og lysdioderne lysdioder lyser grent, skal du gere
blinker ikke. falgende:

1. Kontroller, at spaendingsvaelgeren
bag pé stremforsyningen er angivet
til den rette spaending. Den rette
indstilling af speendingen afhaenger
af det aktuelle omrade.

2. Fjern ét udvidelseskort ad gangen,
indtil lysdioden 3 V_aux pa
systemkortet lyser.

3. Udskift systemkortet.
ELLER

Tryk p& og hold afbryderen nede

i mindre end fire sekunder. Hvis
harddiskens lysdiode ikke lyser grent,
skal du derefter gere folgende:

1. Kontroller, at enheden er tilsluttet
et fungerende stremstik.

2. Abn léget, og kontroller, at
afbryderen er tilsluttet korrekt
til systemkortet.

3. Kontroller, at begge
stremforsyningskabler er tilsluttet
korrekt til systemkortet.

4. Kontroller, at lysdioden 3 V_aux
pd systemkortet lyser. Hvis den
lyser, kan du tilslutte afbryderen
igen.

5. Hvis lysdioden 3 V_aux pa
systemkortet ikke lyser, skal du
bruge en anden stremforsyning.

6. Udskift systemkortet.
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Sikkerhed med adgangskode
og nulstilling af CMOS

Computeren understgtter adgangskodefunktioner, der kan
oprettes fra menuerne i computerens ops@tningsprogram.

Computeren understgtter fglgende to adgangskodefunktioner, der
oprettes via menuerne i computerens ops&tningsprogram: Adgangskode
for ops@tning og adgangskode for start. Hvis der kun oprettes en
adgangskode for opsatning, kan enhver bruger fa adgang til alle
oplysningerne pa computeren undtagen computerens ops@tningsprogram.
Hvis du kun opretter en adgangskode for start, kan ingen fa adgang til
computerens opsatningsprogram og de gvrige oplysninger pa computeren
uden denne kode. Hvis du opretter begge adgangskoder, er der kun
adgang til computerens ops@tningsprogram med adgangskoden for
opsa&tning.

Nar begge adgangskoder er aktiveret, kan adgangskoden for opsatning
bruges i stedet for adgangskoden for start til at tilsidesatte retten til at
logge pa computeren. Dette er en nyttig funktion for
netvaerksadministratoren.

Hyvis du glemmer adgangskoden til computeren, er der to mader, hvorpa
du kan rydde adgangskoden, sa du kan fa adgang til oplysningerne pa
computeren:

B Nulstilling af adgangskodejumperen
B Med knappen til rydning af CMOS

FORSIGTIG: Tryk p& CMOS-knappen for at nulstille vaerdierne

i CMOS til fabriksindstillingerne og slette de tilpassede oplysninger,
herunder adgangskoder, sporingsnumre og specielle indstillinger.

Det er vigtigt at sikkerhedskopiere computerens CMOS-indstillinger
inden nulstilling i tilfselde of, at de skal bruges senere. Det er nemt at
sikkerhedskopiere med computerens opsaetningsprogram. Se Vejledning
til computeropszetning (F10) p& dokumentations-cd’en for at f& oplysninger
om sikkerhedskopiering af CMOS-indstillingerne.

Vejledning til fejlfinding
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Sikkerhed med adgangskode og nulstilling af CMOS

Nulstilling af adgangskodejumper

Fglg nedenstdende fremgangsméade for at deaktivere funktionerne
med adgangskode for opsatning eller start eller for at rydde
adgangskoderne helt.

1. Luk operativsystemet korrekt ned, sluk computeren og
alle tilsluttede enheder, og tag derefter netledningen ud
af stikkontakten.

2. Afbryd netledningen, og tryk pa afbryderen igen for at dreene
systemet for eventuel reststrgm.

ADVARSEL: Tr=k ledningen ud of stikket, og lad de interne komponenter
kele af, for du rarer dem for at mindske risikoen for personskade pé grund
af elektrisk sted og/eller varme overflader.

FORSIGTIG: Stromforsyningen leverer altid spaending fil systemkortet,
ndr computeren er tilsluttet ledningsnettet, selv né&r den er slukket.
Det kan beskadige systemet, hvis ledningen ikke trackkes ud af stikket.

FORSIGTIG: Statisk elekiricitet kan beskadige de elekironiske komponenter
i computeren eller ekstraudstyret. Inden disse procedurer padbegyndes,
skal du sikre dig, at du har afladet dig selv for statisk elektricitet ved

at rere en metalgenstand med jordforbindelse. Se i vejledningen
Oplysninger om sikkerhed og regulativer p& dokumentations-cd’en

for at f& flere oplysninger.

3. Fjern computerens dekplade eller adgangspanel.

4. Find headeren og jumperen.

% Adgangskodejumperen er grgn, sd den er nem at genkende.
Se den illustrerede komponentoversigt til dit system for at finde
adgangskodejumperen og andre komponenter pa systemkortet.
Du kan hente en illustreret komponentoversigt pa webstedet
www.hp.com/support.

5. Tag jumperen vk fra ben 1 og 2. S@t jumperen pa enten ben
1 eller 2 (men ikke pa begge ben), sa den ikke bliver vaek.

6. S@t computerens dekplade eller adgangspanel pa igen.
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Sikkerhed med adgangskode og nulstilling af CMOS

7. Tilslut eksternt udstyr.

8. Sat stikket til computeren i, og teend for strgmmen. Lad
operativsystemet starte. Dette sletter de aktuelle adgangskoder
og deaktiverer funktionerne.

9. Gentag trin 1 til 4, og s@t adgangskodejumperen pa ben 1 og 2
igen, og gentag derefter trin 6 til 8 for at danne nye adgangskoder.
Opret de nye adgangskoder i computerens ops&@tningsprogram.
Se opseetningsvejledningen (F10) pa dokumentations-cd’en for
at fa en vejledning til computerens opsa&tningsprogram.

Rydning og nulstilling af CMOS

Computerens CMOS (konfigurationshukommelse) lagrer oplysninger
om adgangskoder samt oplysninger om computerens konfiguration.

Brug af CMOS-knappen

1. Sluk computeren og de eksterne enheder, og traek ledningen
ud af stikkontakten i vaeggen.

2. Afbryd tastatur, skerm og andet eksternt udstyr, der er tilsluttet
computeren.

ADVARSEL: Trck ledningen ud of stikket, og lad de interne komponenter
kele af, fer du rerer dem for at mindske risikoen for personskade pé grund
af elekirisk stad og/eller varme overflader.

FORSIGTIG: Stromforsyningen leverer altid spaending til systemkortet,
ndr computeren er filsluttet ledningsnettet, selv nar den er slukket. Det
kan beskadige systemet, hvis ledningen ikke traekkes ud af stikket.

FORSIGTIG: Statisk elekiricitet kan beskadige de elekironiske komponenter
i computeren eller ekstraudstyret. Inden disse procedurer p&dbegyndes,
skal du sikre dig, at du har afladet dig selv for statisk elektricitet ved

at rere en metalgenstand med jordforbindelse. Se i vejledningen
Oplysninger om sikkerhed og regulativer p& dokumentations cd’en

for at f& flere oplysninger.
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Sikkerhed med adgangskode og nulstilling af CMOS

3. Fjern computerens dekplade eller adgangspanel.

FORSIGTIG: Tryk pd CMOS-knappen for at nulstille vaerdierne i CMOS til
fabriksindstillingerne og slette de tilpassede oplysninger, herunder adgangskoder,
sporingsnumre og specielle indstillinger. Det er vigtigt at sikkerhedskopiere
computerens CMOS-indstillinger inden nulstilling i filfselde of, at de skal bruges
senere. Det er nemt at sikkerhedskopiere med computerens opsaetningsprogram.
Se Vejledning til computeropsaetning (F10) p& dokumentations-cd’en for

at f& oplysninger om sikkerhedskopiering of CMOS-indstillingerne.

4. Find, tryk pa og hold CMOS-knappen nede i fem sekunder.

%\ Kontroller, at du har taget netledningen ud af stikket i vaeggen.
CMOS-knappen rydder ikke CMOS’en, hvis netledningen er tilsluttet.

CMOS-knap

% Se den illustrerede komponentoversigt til dit system for at
finde CMOS-knappen og andre komponenter pa systemkortet.

5. Sat computerens dekplade eller adgangspanel pa igen.
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Sikkerhed med adgangskode og nulstilling af CMOS

AN

6. Tilslut de eksterne enheder igen.

7. Set stikket til computeren i, og teend for strgmmen.

Der vises POST-fejlmeddelelser, nar CMOS er ryddet og efter genstart,
som informerer dig om, at der er sket @ndringer i konfigurationen.
Brug computerens ops@tningsprogram til at nulstille adgangskoder
og eventuelle serlige systemopsatninger tillige med dato og klokkeslzt.

Se Desktop Management Guide pa dokumentations-cd’en for
at fa flere oplysninger om genetablering af adgangskoder.

Se opseetningsvejledningen (F10) pa dokumentations-cd’en
for at fa flere oplysninger om computerens ops&tning.

Brug af computerens opsatningsprogram
til at nulstille CMOS

Fgr du kan nulstille CMOS via computerens ops@tningsprogram,
skal du fgrst Abne menuerne i computerens ops&tningsprogram.

Tryk pa F10-tasten, nar computeropsatningsmeddelelsen vises
i nederste hgjre hjgrne af skeermen. Tryk eventuelt pa Enter for
at springe startskermbilledet over.

Hvis du ikke trykker pa F10-tasten, nar meddelelsen vises, skal du
slukke computeren og teende igen for at fa adgang til hjelpeprogrammet.

Menuen for hjelpeprogrammer til computerops@tning giver fem
valgmuligheder: File, Storage, Security, Power og Advanced.

Indstil fgrst dato og klokkeslet, og brug derefter piletasterne

eller tabulatortasten til at valge File > Set Defaults and Exit
for at nulstille CMOS til standardindstillingerne. Derved nulstilles
indstillingerne, herunder startreekkefglge og andre fabriksindstillinger.
Hardwaren opdateres imidlertid ikke igen.

Se Desktop Management Guide pa dokumentations-cd’en for
at fa flere oplysninger om genetablering af adgangskoder.

Se opscetningsvejledningen (F10) pa dokumentations-cd’en
for at fa flere oplysninger om computerens ops&tning.
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C

DPS (Drive Protection System)

DPS (Drive Protection System) er et diagnosevarktaj, der er indbygget
i de harddiske, som er installeret i visse computere. DPS er designet

til at athjelpe de diagnosticeringsproblemer, der kan fgre til ugnsket
udskiftning af harddiske.

Nar disse systemer bygges, testes hver harddisk ved hjelp af DPS,
og en permanent fortegnelse over nggleoplysningerne skrives

pa drevet. Hver gang DPS kgres, skrives testresultaterne pa
harddisken. Serviceyderen bruger disse oplysninger til at athjelpe
de diagnosticeringsproblemer, der gjorde det ngdvendigt at kgre
DPS-softwaren.

Kgrsel af DPS péavirker ikke programmer eller data, der er lagret pa
harddisken. Testen findes i harddiskens firmware og kan udfgres, selv
nar computeren ikke vil genstarte et operativsystem. Den tid, det tager
at udfgre testen, athenger af producenten og harddiskens stgrrelse.

I de fleste tilfelde varer testen cirka to minutter pr. GB.

DPS bgr bruges ved mistanke om et harddiskproblem. Hvis computeren
viser en meddelelse om SMART Hard Drive Detect Imminent Failure
(en alvorlig harddiskfejl), er der ingen grund til at kgre DPS. Du skal
i stedet sikkerhedskopiere oplysningerne pa harddisken og kontakte
en serviceyder for at fa en ny harddisk.
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DPS (Drive Protection System)

Adgang til DPS via Diagnostics for Windows

Fglg fremgangsmaden nedenfor for at fa adgang til DPS via
Diagnostics for Windows:

1.

Tand computeren, og velg Start > Kontrolpanel > Diagnostics
for Windows.

Der vises fem mulige overskrifter pa skarmbilledet Diagnostics:
Overview, Test, Status, Log og Error.

. Veelg Test > Type of Test.

Der vises tre test, du kan velge imellem: Quick Test, Complete
Test og Custom Test.

. Vaelg Custom Test.

Der vises to testtilstande: Interactive Mode og Unattended Mode.

. Valg Interactive Test > Storage > Hard Drives.

5. Vealg de specifikke drev, der skal testes Drive Protection System

Test > Begin Testing.

Nar testen er udfgrt, vises en af fglgende tre meddelelser for hvert
drev, der er testet:

Test Succeeded (testen er korrekt udfgrt). Afslutningskode 0.
Test Aborted (testen blev afbrudt). Afslutningskode 1 eller 2.

Test Failed (testen mislykkedes). Det anbefales at udskifte disken.
Afslutningskode 3 til 14.

Hyvis testen mislykkes, skal afslutningskoden noteres og rapporteres
til serviceyderen, sa du kan fa hjalp med diagnosticering af
computerproblemet.

c-2
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DPS (Drive Protection System)

Adgang til DPS via computerens
opsatningsprogram

Hvis computeren ikke tender korrekt, skal du bruge computerens
ops@tningsprogram til at fa adgang til DPS-programmet. Fglg
fremgangsmaden nedenfor for at f4 adgang til DPS:

1. Tend, eller genstart computeren.

2. Tryk pa F10-tasten, nar F10-opsatningsmeddelelsen vises nederst
til hgjre pa skeermen.

Hvis du ikke trykker pa F10-tasten, nar meddelelsen vises, skal du
slukke computeren og teende igen for at fa adgang til hjelpeprogrammet.

Menuen for hjelpeprogrammer til computerops&tning giver fem
valgmuligheder: File, Storage, Security, Power og Advanced.

3. Valg Storage > DPS Self-Test.

P4 skaermen vises en liste over harddiske med DPS, der
er installeret pa computeren.

Hyvis der ikke er installeret harddiske med DPS-egenskaber, vises
indstillingen DPS Self-Test ikke pa skermen.

4. Valg den harddisk, der skal testes, og folg vejledningen
pa skaermen for at gennemfgre testen.

Nar testen er udfgrt, vises én ud af fglgende tre meddelelser:
B Test Succeeded (testen er korrekt udfgrt). Afslutningskode 0.
B Test Aborted (testen blev afbrudt). Afslutningskode 1 eller 2.

B Test Failed (testen mislykkedes). Det anbefales at udskifte disken.
Afslutningskode 3 til 14.

Hyvis testen mislykkes, skal afslutningskoden noteres og rapporteres
til serviceyderen, sa du kan fa hjalp med diagnosticering af
computerproblemet.

Vejledning til fejlfinding

www.hp.com C-3



D

Indstilling af analogt/digitalt lydoutput

Nogle computere har integrerede lydlgsninger, der understgtter eksterne
analoge eller digitale stereohgijttalere. Disse systemer registrerer automatisk
hgjttalernes type og sender det korrekte signal. Gennemfgr procedurerne
i det fglgende iht. operativsystemet for manuelt at skifte mellem
indstillingerne analog, digital og auto-sense.

% Hyvis du veelger digitalt som outputtilstand, udsender den interne
hgjttaler og de eksterne analoge hgjttalere ikke lyd, fgr du skifter
tilbage til en auto-sense- eller analog tilstand. Hvis du valger analogt
som outputtilstand, fungerer de eksterne digitale hgjttalere ikke, fgr
du @ndrer outputtilstanden til en auto-sense- eller digital tilstand.

I Microsoft Windows XP:

1. Klik pa Start > Kontrolpanel, og dobbeltklik derefter pa ikonet
for lyd, tale og lydenheder.

2. Klik pa fanen Hardware.

3. Marker den relevante lydenhed.

o

. Klik pa Egenskaber for at ébne vinduet Egenskaber for
enheden.

. Klik pa fanebladet Egenskaber.

. Klik pa “+” ved siden af Lydenheder for at udvide dette punkt.
. Marker den gnskede driver ved at klikke péa den.

. Klik pa Egenskaber.

. Klik pa Indstillinger.

O 0 3 O W

10. Rediger outputtilstanden til den gnskede indstilling.
11. Klik pa OK for at lukke vinduet Egenskaber.
12. Luk Kontrolpanel.
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